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Safety and Preparation for Use

CAREFULLY READ THE IMPORTANT SAFETY INSTRUCTIONS AND NOTES
INCLUDED IN THIS SECTION BEFORE USING THE OPTIMELT AUTOMATED

MELTING POINT SYSTEM AND ANY OF ITS ACCESSORIES.

Within this section, the word 'product' specifically refers to the OptiMelt Automated

Melting Point System and any of its accessories.

This product is designed and built for use in synthetic and analytical chemistry

laboratories. It is intended to be used to determine melting temperatures and melting

ranges between ambient and 400°C temperatures.

Safety risks are associated with all research and production activities. Though long

experience has proven melting point instrumentation to be remarkably safe, hazards are

always associated with analytical equipment. The most effective way to minimize risk to

yourself and others is to read, and strictly follow, all safety instructions and warnings

during the installation, operation and maintenance of all equipment used in your

laboratory.

The intent of this section is to collect, in a single place, the most common risks associated

to the installation, operation and maintenance of this product. The instructions are also

repeated, with additional information, at the appropriate points throughout this manual.

This product has been designed with user safety as a priority and has been proven to

show reasonably safe operation provided it is installed, operated and serviced in strict

accordance with all the safety instructions included in its manual

Safety Instructions and Warnings

• SAFETY PAYS! Safety instructions must be strictly followed during all stages of

installation, operation and service of this product. Failure to comply with these

precautions and warnings violates the safety standards expected of users of this

product.

• This Operations Manual is a component of the product and must remain readily

available to all laboratory personnel with access to the OptiMelt Melting Point

System.

• If you have any doubts about how to use this product safely, contact Stanford

Research Systems using the contact information provided in this manual.

• Do not use this product for any purpose other than its intended usage.

• Retain these safety and operating instructions for future reference.

• Identify and adhere to all warnings posted on the product and throughout this manual.

• Failure to comply with these instructions may result in serious personal injury,

including death, as well as significant property damage.
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• This instruction manual should form the basis of any training requiring the use of this

product.

• Wear protective garments such as lab coat and goggles at all times.

• Refer servicing to qualified personnel only.

Product Placement Requirements

• Place this product on a stable, clean, level and even surface.

• Place the product away from water sources (i.e. faucets, safety showers, eyewashes,

rain, etc.) Do not allow the product to become wet.

• No containers, chemicals or other appliances should be placed behind the product.

• Always operate the unit in its proper upright orientation. Do not operate the

unit on its side.

• To prevent damage to the product and ensure sufficient cooling in the electronic

compartment, place the sidewalls of the unit at least 10 cm away from walls or other

objects.

• Your OptiMelt may produce some smoke the first time it is heated. The smoke is

caused by residual oils coating the metal surfaces of the heater and surrounding areas.

Once the oils burn away, the smoke will permanently cease.

Electrical Shock Risks

The most common risk associated with the operation of chemical

instrumentation equipment is electrical shock.

• It is your responsibility to install and operate this product in full
conformance with local electrical codes. Consult an experienced electrician if

necessary.

• If the power cord becomes damaged, replace it immediately.

• Dangerous voltages capable of causing injury are present during the operation of this

product. Do not remove the covers while the unit is plugged into a live

outlet.

• Do not use this product if it has unauthorized modifications. Unauthorized

modifications may result in fire, electric shock and other hazards.

• Do not install substitute parts or perform any unauthorized modifications to this

instrument.

• The line fuse is internal to the instrument and may not be serviced by
the user.

• Always use an outlet which has a properly connected protective

ground. Consult with an experienced electrician if necessary.

• GFCI (Ground Fault Circuit Interrupter) protected outlets are often available in

laboratory environments, particularly in proximity to water sources. GFCI's are
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generally regarded as an important defense against electrocution. However, the use

of a GFCI in conjunction with the OptiMelt must NOT be regarded as a

substitute for proper grounding and careful connections. GFCI's must also

be tested regularly to verify their functionality. Always consult an electrician when in

doubt.

• Do not use accessories not recommended in this manual as they may be hazardous.

• Always turn off the power to the instrument before connecting any
cable or accessory to the unit.

• Keep all electrical wiring on your laboratory benches neatly organized and in good

working conditions. Label and color-code all high voltage cables. Inspect all HV

wires periodically for problems as part of your safety checkups.

• Use tie downs and cable channels to hold all electrical wiring in place (i.e. no

dangling cables).

• Keep all electronic instrumentation neatly organized, and remove unconnected cables

power supplies and connectors from your laboratory benches and shelves.

• Do not push objects of any kind into this product through openings as they may come

in contact with dangerous voltage points or short out parts that could result in a fire

or electric shock.

• Operation of this product with line voltages other than those accepted by the power

supply can cause damage to the instrument and injury to personnel.

Burn Risks

A common risk associated specifically with the operation of thermal

analysis instrumentation equipment is burns.

• Observe, and respect, the “HOT LID” warning on the top surface of the product.

• Do not touch the heater block while hot.

• Check the temperature of the block before opening its compartment.

Explosion Risks

Injury due to explosion is another important safety concern during the

operation of thermal analysis instrumentation.

• This product is not compatible with application environments requiring: explosion-

proof equipment, or compatibility with samples which may explode or ignite by heat,

friction or spark.

• Do not use this product to analyze samples of unknown composition or

contamination.
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Front Panel Overview

Figure 1. Front Panel of OptiMelt.

LCD Display and Touchscreen

A simple front panel, including a touchscreen LCD display with menu driven interface,

displays temperature measurements, menus and step-by-step instructions throughout the

determination process.

Observation Window (with lens and illumination)

A wide observation window, with a large magnification lens and internal illumination,

allows users to observe the samples and determine their melting points visually.

Power LED

A red Power LED lights up to indicate that the unit is turned on.
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Ready LED

A green Ready LED lights up or flashes to prompt the user’s attention.

The Ready LED lights up to indicate that the oven is stabilized at the Start Temperature.

The Ready LED flashes to indicate completion of a determination and to prompt the

availability of a new melting point report.
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Back Panel Overview

Figure 2. Back Panel of OptiMelt.

Sample holding area

As many as three samples may be analyzed simultaneously using glass capillary tubes. A

small metal block provides fast heating cycles under tight computer temperature control

and in strict compliance with modern pharmacopeia methodologies. A precision platinum

resistance thermometer provides accurate and reproducible temperature readings with

0.1 ºC resolution.

Capillary Receptacle

Two separate glass capillary holders, located on top of the instrument, are available to

store empty and discarded capillary tubes.

External Thermometer

OptiMelt includes a back panel connection and front panel temperature display for an

external 100  platinum RTD (  = 0.00385 / /°C) thermometer. Use OptiMelt with an

optional external thermometer to measure temperatures around your lab between melting

point determinations.
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Printer

OptiMelt includes a back panel RS-232 connector for an optional serial printer. The DB9

connector is compatible with standard RS-232 cables.

Compatible printers include Epson, Citizen and generic (text only) dot matrix serial

printers.

Power Entry Module

The Power Entry Module is used to connect the OptiMelt to a power source through the

power cord provided with the instrument. The center pin is connected to the OptiMelt

chassis so that the entire box is grounded. Connect OptiMelt to a properly grounded

Outlet. Consult an electrician if necessary.

OptiMelt is turned on by flipping the power switch on the Power Entry Module.

The source voltage requirements are: 90-264 VAC, 47-63 Hz, 125W.

USB

OptiMelt comes standard with a USB communications port.

The optional MeltView software package can handle real-time image transfer, allowing

OptiMelt users to display and store high resolution digital images of the samples

(including relevant information such as temperature, time and date) on your computer

screen during analysis.
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Specifications

Operation

Temperature display Melting point and melting point range

Temperature range (Room temperature + 10 °C) to 400 °C

Temperature resolution 0.1 °C

Ramp rate 0.1 °C to 20 °C per minute

Heat-up time ~10 minutes (50 °C to 350 °C)

Cool-down time ~10 minutes (350 °C to 50 °C)

Temperature accuracy ±0.3 °C (up to 100 °C)

±0.5 °C (up to 250 °C)

±0.8 °C (up to 400 °C)

Reproducibility 0.2 °C

Temperature sensor Pt RTD (built-in)

Oven control Closed loop PID

External Sensor User supplied, 100  Pt RTD,  = 0.00385 / /°C

General

Display Back-lit, 5.8" (diag.) touchscreen LCD

Printer interface RS-232 serial port. Supports Epson and Citizen compatible dot

matrix printers.

Computer interface USB. All instrument measurements may be performed using

the optional MeltView software.

Capillaries

Dimensions 1.4 mm to 2.0 mm outside dia., 100 mm length

Capacity Up to 3 tubes simultaneously

Fill height 2 mm to 3 mm

Power 90 to 264 VAC, 47 to 63 Hz, 125 W

Operating temperature 0 °C to 40 °C, non-condensing

Weight 9 lbs.

Dimensions 7.5" x 10" x 8.5" (WxHxL)

Warranty One year parts and labor on defects in materials and

workmanship
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Chapter 1 

Getting Started

Unpacking

Before You Open the Box

Read the entire Safety and Preparation for Use section of this manual before starting any

installation procedure.

Read and follow all installation and operation instructions in this manual to ensure that

the performance of this instrument and the accuracy of your melting point determinations

is not compromised.

Checklist

• Open the box(es) and inspect all components of your OptiMelt System.

• Report any damage to Stanford Research Systems immediately.

• Compare the contents of the shipping boxes against your original order and the

checklist below. Report any discrepancies to Stanford Research Systems

immediately.

Standard Equipment Supplies

• Melting Point Apparatus (OptiMelt, SRS Part# MPA100)

• Operation and Service Manual

• One (1) Power Cord

• Two (2) glass Capillary Holders

• One (1) Glass Window

• One (1) Ceramic Insulator

• One pack of Capillary Tubes (100 count)

Optional Equipment

• Printer, with cable and paper (SRS Part# O100P)

• Sample Capillaries (300pcs) (SRS Part# O100MPC)

• Melting Point Standards Kit (O100MPS)

• Replacement Glass Window (SRS Part# O100GW)

• Replacement Capillary Holder (SRS Part# O100CH)



2 Getting Started Chapter 1

OptiMelt Automated Melting Point System

Instrument Placement

• Place your OptiMelt on a stable, clean, level and even surface.

• Place your OptiMelt away from water sources (i.e. faucets, safety showers,

eyewashes, rain, etc.) Do not allow the unit to become wet.

• No containers, chemicals or other appliances should be placed behind the product.

• Always operate the unit in its proper upright orientation. Do not operate the unit on

its side.

• To prevent damage to your OptiMelt and ensure sufficient cooling in the electronic

compartment, place the sidewalls of the unit at least 10 cm away from walls or other

objects.

• Your OptiMelt may produce some smoke the first time it is heated. The smoke is

caused by residual oils coating the metal surfaces of the heater and surrounding areas.

Once the oils burn away, the smoke will permanently cease.

Mounting of Accessories

Capillary Holders

Insert the glass Capillary Holders into the two openings located on the top surface of the

metal housing.

Figure 3. Mounting the glass Capillary Holders.
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The Capillary Holders are used to (1) store unused and discarded capillaries, (2) guard

the unit against dust and small particles and (3) protect the user from touching live

electrical parts.

Warning!
Do not put your unit into operation without the Capillary Holders in place.

Glass Window

Insert the Glass Window into the heating block. Remove the blue metal lid located on the

top of the unit. Slide the glass window into the vertical slot located on the front face of

the heating block as depicted in Figure 4.

The Glass Window is designed to (1) thermally insulate the sample capillaries from

ambient, (2) allow uniform heating of the three capillary slots and (3) provide a clear

view of the samples. The sliding assembly facilitates cleanup of the window and the

block in the case of capillary breakage inside the oven.

Figure 4. Inserting the Glass Window into the heating block.
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Ceramic Insulator

Place the Ceramic Insulator on top of the heating block as depicted in Figure 5. Replace

the lid when finished.

Figure 5. Placing the Ceramic Insulator on top of the metal heating block. Two metal pins,

located on top of the oven, secure self-alignment of the assembly.

The Ceramic Insulator is designed to (1) reduce heat losses from the metal oven into

ambient and (2) guide the capillary tubes into the metal heating block, reducing the

chances of capillary breakage inside the oven.

Warning!
Do not operate your OptiMelt without its metal lid in place.
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Printer

If a printer is to be used, it should now be connected to your OptiMelt using the RS-232

connection cable provided with your printer.

Figure 6. Printer (RS-232) port and External RTD connector on the OptiMelt back panel.

Inspect your printer and load a new roll of paper if necessary. Consult the Printer

Configuration section later in this chapter for additional information.

External Thermometer

OptiMelt includes a back panel connection for a user supplied, external 100 ,

 = 0.00385 / /°C, platinum RTD thermometer. Use this thermometer to measure

temperatures around the lab between melting point determinations. Two, three and four

wire connector configurations are available. The four-wire connection provides

measurements which are independent of the wire length and is recommended by SRS.

Locate the External 100  Pt RTD connector on the back of the OptiMelt (see Fig. 3).

Disconnect the terminal block plug from the connector and use it to connect to an

external Pt RTD thermometer. Wiring instructions are shown below.

External 100  Pt RTD Thermometer Wiring Instructions

4 wire configuration 3 wire configuration 2 wire configuration

Pin 1 Current Source Supply Current Source Supply Connect to Pin 2

Pin 2 Voltage Sense (+) Voltage Sense (+) Voltage Sense (+) &
Current Source Supply

Pin 3 Voltage Sense (-) Voltage Sense (-) &
Current Source Return

Voltage Sense (-) &
Current Source Return

Pin 4 Current Source Return Connect to Pin 3 Connect to Pin 3

Spare terminal blocks are available from Stanford Research Systems.
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Principle of Operation

The OptiMelt system sets a new standard in ease-of-use. OptiMelt is the only melting

point apparatus to use a touchscreen LCD interface to display up-to-date information and

instructions during the analysis process. There is no need to learn how to use OptiMelt –

the instrument guides you through the analysis steps. Interactive help and timely

suggestions are also available for all important functions and parameters of the

instrument. Text and numerical entry keypads are built into the touchscreen interface.

Distinct beeps and bright front panel LEDs announce important events such as

temperature stabilization or end of melt.

OptiMelt relies on the capillary method supported by virtually all pharmacopeia

procedures for melting point determinations. The inclusion of three independent sample

slots in the heating block allows simultaneous analysis of up to three samples, thus

ensuring high sample throughput.

Microprocessor control of both heating and cooling cycles and a small metal oven design

provide fast and repeatable warmup and cool down cycles and tight temperature

regulation (0.1 ºC resolution) during analysis. Microprocessor controlled temperature

ramping eliminates the inconsistencies and overshoots typically associated with manually

adjusted models.

A typical analysis only takes a couple minutes to set-up:

• Select a Start temperature (ºC)

• Select a Stop temperature (ºC)

• Select a ramping Rate (ºC/minute)

• Follow the step-by-step instructions displayed on the Melt screen

Figure 7. Melt Screen. Use the Start, Stop and Rate/min buttons to program the instrument.

Follow the on-screen instructions to complete the analysis.

In a typical analysis, the Start temperature is programmed a few degrees below the

expected onset of the melting point, and the Stop temperature is selected to exceed the

melting point ranges of the compound(s) being tested. Programmable ramp rates from

0.1 ºC/min to 20 ºC/min, in 0.1ºC/min increments, provide measurement flexibility.

The unit first heats up (at its maximum rate) to the Start temperature and remains

stabilized at that temperature until the user is ready to carry out the test. During analysis,
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the temperature is ramped, at the specified fixed ramping Rate, between the Start and

Stop temperatures. Automated and/or visual analysis takes place during this time.

Figure 8. Analysis Heating Cycle.

OptiMelt was specifically designed to detect and determine melting points with

completely unattended operation. A built-in digital camera continuously captures real-

time images of the samples throughout the analysis. Sophisticated Digital Image

Processing technology is applied to detect and determine melting points from the analysis

of those images. The melting points and melting ranges determined by the digital image

processor are prominently displayed on the front panel, and automatically recorded into

memory in a Summary Report for later review. If required, the samples can also be

viewed at any time, and the melting points determined visually. Visualization is relevant

for colored or problematic samples, for chemists trying to reproduce published visual

observations, and for synthetic chemists generating new, intermediate or exotic

compounds.

Once the heating cycle is completed and the melts are detected (automatically and/or

visually) the OptiMelt automatically cools down, back to the Start temperature in

preparation for the next test.

Tip
If the melting point is completely unknown, the maximum heating rate of 20 ºC/min and

a large temperature range can be used to obtain an approximate estimate of the melting

points, followed by a more accurate determination with a lower heating rate and a

reduced temperature range.

The ability to rapidly preheat the oven to a start temperature slightly below the expected

melting point and remaining at that temperature until the user is ready to load the

capillary samples reduces the analysis time considerably, provides more accurate results

and minimizes the time delicate samples are exposed to damaging high temperatures.

For details on the principle of operation of automated determinations consult the

“Automated Analysis” section later in this chapter.

Ambient
Temp
(Oven Off)

Start
Temp

Stop
Temp

Preheat:

Maximum
Heating
Rate

Hold:

Start Temp

Ramp:

Selected Heating Ramp
Rate/minute

Cool Down:

Fan assisted

Time
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Quick Start Instructions

This section includes Quick Start instructions for a melting point determination with

sample(s) of known melting point(s).

1. Connect the power and optional printer

With the power switch in the Off position, connect your OptiMelt to a grounded outlet

using the power cord provided.

Connect your optional printer to a grounded outlet and power it up.

2. Turn on power

Turn the power switch on and wait for the brief Power-on Self Test procedure to be

executed. The Melt Screen is displayed on the touchscreen LCD. The oven is off at this

time.

Tip
A warm up period of at least 30 minutes is recommended before use.

3. Configure the optional printer

Configure the OptiMelt’s printer settings using the instructions listed in the “Printer

Configuration” section later in this chapter.

4. Prepare the sample(s)

OptiMelt relies on the capillary method for melting point determinations. Capillary

sample tubes are included with your OptiMelt.

Do not insert the sample capillaries into the OptiMelt’s oven at this time. Store the

loaded capillaries in a safe place while programming the instrument.

Tips
• Any substance being loaded into a melting point capillary must be fully dry,

homogeneous and in powdered form. Granular crystalline and non-homogeneous

samples must be crushed in a mortar and then loaded into the melting point capillary

to a height of 2–3 mm.

• Up to three samples can be accommodated in the metal oven. All three capillaries

must be filled to the same height, and compacted in a similar way, to ensure

comparable results. Compaction of the samples is obtained by: (1) knocking the

capillaries on a hard surface and/or (2) compressing the sample plug with a

compaction wire.

• A detailed discussion of the capillary melting point determination methodology,

including sample preparation steps, is included in Chapter 3 of this manual.
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5. Enter the Start temperature (°C)

The Start temperature is programmed by touching the Start button on the touchscreen

LCD and entering a number using the displayed numeric keypad.

The Start temperature is the temperature at which the sample capillaries are introduced

into the heating stand, and serves as the starting point for the heating ramp.

Tip
The Start temperature should be at least 5 °C below the known melting point of the

sample(s).

6. Enter the Stop temperature (°C)

The Stop temperature is programmed by touching the Stop button on the touchscreen

LCD and entering a number using the displayed numeric keypad.

The Stop temperature is the temperature at which the heating ramp is terminated.

Tip
A Stop temperature at least 10 °C higher than the Start temperature is recommended for

this procedure.

7. Enter the ramp Rate (°C/min)

The ramp Rate is programmed by touching the Rate/min button on the touchscreen LCD

and entering a number using the displayed numeric keypad.

The ramp Rate is the fixed rate of temperature rise between the Start and Stop

temperatures for the heating ramp (see Fig. 5). A ramp Rate of 1 °C/min is recommended

for routine determinations. For ramping rates of 1 °C/min, a melting range of about 1–2

°C is typically recorded for pure substances.

Tip
The ramp Rate is the most important instrument parameter affecting the

accuracy and reproducibility of measurement of melting points. Rates up to

2 °C/min are reasonable for routine determinations. Higher rates are only recommended

for quick determinations on substances with unknown melting points. Purity

determination and precision measurements are performed at a maximum heating rate of

0.5 °C/min, though the recommendation is to stay at 0.1–0.2 °C/min whenever feasible.

Samples that start to decompose at temperatures below their melting point, are usually

measured at ramp rates above 5 °C/min to avoid contamination from byproducts. Mixed

melting point determinations (described later) can be performed with ramp rates as large

as 10 °C/min.
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8. Preheat the oven to the Start Temperature

Touch the Heat button on the Melt screen to rapidly preheat the oven to the Start

Temperature.

An audible tone is heard and the Ready LED is turned on as soon as the Start temperature

is reached and becomes stable

OptiMelt is now ready for a melting point determination.

9. Insert the sample capillaries

Insert the capillary sample tube(s) into the oven and wait a few seconds for the

temperature of the oven to stabilize.

Tips
• Never force a capillary into the heating block! Once the capillary is inserted into a

sample hole, it should literally drop down to the bottom of the heating stand.

• Introducing the capillaries at this time minimizes sample exposure to high

temperatures. This is a very important consideration for labile samples which melt

with decomposition.

10. Initiate Heating Ramp

Touch the Start Button on the Melt Screen to initiate the temperature ramp and the

automated melt determination process. After a brief delay the oven temperature will

commence to rise at the specified ramp Rate. The capillary tubes must not be disturbed

while the ramping takes place. The heating ramp is terminated when (1) the Stop

temperature is reached or (2) when the Halt button is touched.

Touch the Graph button at any time to view the evolution of the Melt Graph generated by

the Digital Image Processor during the ramping process.

Touch the Halt button at any time to terminate the heating process before the Stop

temperature is reached.

Tip
Use the Halt button if the sample(s) is observed to completely melt before the Stop

temperature is reached. The actual Halt temperature is recorded in the test report.

11. View the Melt

Visualization of the melt during the heating ramp is via the observation window located

on the front panel of OptiMelt. All three capillaries can be observed simultaneously.

All important changes that take place in the capillary tubes can be manually flagged by

touching the individual “sample buttons” located at the bottom of the Melt screen. The

three samples are identified as Left, Center and Right according to their physical location

in the heating block.
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Figure 9. Use the Sample Buttons to flag important changes in the samples during the analysis.

At the end of the analysis, all manual and automated results are saved in a report and the

heater stand is automatically cooled back down to the Start temperature in preparation for

the next determination. A hard copy of the Report is also printed out if an optional printer

is connected and OptiMelt is configured for automated print out of results (See “Printer

Configuration” section later in this manual).

A distinct audible alarm and a blinking Ready LED prompt the availability of a new

Report.

Important!
Samples cannot be remelted! All melted capillaries MUST BE DISCARDED at the end

of the analysis.

12. Recall the information

Touch the Report button to display a summary Report for the melting point determination

performed. The Newest Report is displayed on the screen.

Compare the results to the known melting point(s) of the substance(s) analyzed.

Figure 10. Melt Report screen.

Tip
OptiMelt stores the last eight Melt Point Reports in memory. Touch the Select button to

choose a Report to display.
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Touch the Print button to generate a hard copy of the Newest Report if an optional printer

is connected to your OptiMelt. Supported printers featuring graphics capabilities include

Melt Graphs in all hard copies of Reports.

Touch the Graph button to review the Melt Graphs associated to the Newest Report.

Each Report includes all automated (camera) and manual (visual) results collected

throughout the analysis. It also lists all relevant setup and calibration information

required for proper documentation and certification of the analysis results. Two separate

tables summarize the automated and visual results. The melting point range of the

samples is defined as the temperature interval bracketed by the Onset and Clear points

listed in the automated results. No automated results are displayed for sample slots that

do not contain capillaries or for samples that do not melt during the analysis.

13. Prepare for the next melt

OptiMelt automatically cools down to the Start temperature at the end of a melt in

preparation for the next melting point determination.

Important!
Samples cannot be remelted! Always start a new determination with fresh capillaries.

14. Turn Oven Off

The OptiMelt System was designed with Safety as a top priority.

The oven can only remain at Start temperature for a time interval equal to the Timeout

programmed in the Options menu. An automatic shut-off system turns off the power to

the oven if no user input is experienced during that time.

Touching the Oven Off button in the Options menu is another way to turn off the heating

to the oven at any time.
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Printer Configuration

Your OptiMelt system includes a serial printer interface. Text and graphical hardcopy of

melting point Reports is available with several different printers (RS-232C serial

interface) including Citizen, Epson and even generic models. The use of high speed, dot

matrix printers with graphical capabilities is recommended for hardcopy records of your

Reports. A generic driver is also included for printers not supported specifically by the

OptiMelt drivers or which do not support graphical capabilities.

Figure 11. OptiMelt system with printer.

Tip
Thermal and Inkjet Printers are not recommended for documentation since their records

tend to fade rapidly when exposed to ambient light. This renders them incompatible with

GLP requirements.

If a line printer is to be used as part of your OptiMelt system it should be properly

configured as follows.

1. Touch the System Tab to access the System Menu.

Use the System menu to test and configure important functions of your OptiMelt

including: PC interface, printer interface, touchscreen/LCD setup, date/time,

temperature scale calibration and camera alignment.

2. Touch the Printing button to access the Printing Submenu. This submenu includes all

the configuration options relevant to the printer.

3. Touch the Printer button to select a printer driver compatible with the printer

connected to your OptiMelt unit.

Select Citizen to printout results on a Citizen dot matrix printer. For example,

iDP3550-F40RFG and related models.
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Select Epson to printout results on an Epson dot matrix printer. For example,

TM-U220 and related models.

Select Generic to printout results on a generic serial dot matrix printer or a printer

which does not support graphical output.

If none of the available drivers works properly with your printer, consult the printer’s

user manual and use the individual: Baud, Word Length, Parity, Flow Control and

LineFeed settings to program your printer interface. Most printers also include dip-

switches that the user can access to adjust communication settings to match the

settings used by the OptiMelt drivers.

4. Touch the Test print button to transmit the string “SRS OPTIMELT” to the printer

output buffer.

The text should be printed out if the proper printer driver is selected, the cables are

properly connected, the dip switches are properly set and the printer is turned on and

on-line.

Tip

Use the Test print button to test the integrity of your printer interface and to make

sure the proper printer driver, cable connection and printer settings are selected.

5. Touch the Melt Tab to access the Melt Screen.

6. Touch the Options button to access the Options menu.

7. Touch the Printout button and choose between Manual or Automatic printout of the

final Test Report at the end of a melt.

Manual means that the user must manually display and printout reports from the

Report Screen after the melting point determination is completed.

Auto means that OptiMelt automatically prints out a report at the end of a melting

point determination whenever a printer is properly connected to the instrument.

8. Touch the Melt Tab to return to the Melt Screen.
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Automated Analysis

The OptiMelt system is unique among melting point analyzers in being the first to use a

built-in digital camera to capture real-time images of the samples and Digital Image

Processing (DIP) technology to determine phase transitions from the analysis of those

images.

The high-resolution camera can easily detect and interpret minute changes in the optical

characteristics of the capillary samples in a manner similar to your own eyes. This

effectively eliminates the need for the user to be present during the analysis and avoids

the subjectivity of visual melting point determinations. Even colored or easily

decomposed samples can often be accurately determined in this fashion.

The unattended melting points and melting point ranges determined by the OptiMelt

system closely match visual results and provide a dramatic improvement over the

measurements delivered by analyzers relying on more primitive and limited bulk optical

absorption and reflection techniques.

In order to provide a real-time display of the changes in optical appearance observed by

the camera and interpreted by the DIP during the analysis, a simplified graphical

representation of the “melting process vs. temperature” is generated. This “Melt Graph”

is a two dimensional representation of the melt calculated by the DIP and stored in

memory as part of the final Report. The DIP determines the onset, clear and single point

temperatures from the Melt Graph based on user programmable detection thresholds

(Onset%, Clear% and Single%, respectively).

Figure 12. Typical Melt Graph from the analysis of a pure white solid that melted without

decomposition. The onset, meniscus and clear points are readily identified by the Digital Image

Processor using the default detection threshold values of 70%, 50% and 10%, respectively. Screen

cursors are available to analyze the graph and fine tune analysis results.

Melt Graphs are routinely used to (1) follow real-time changes in the samples during

analysis, (2) fine tune automation parameters (i.e. detection thresholds) to better match

visual with automated determinations and (3) to identify the end of the melt (without

having to keep a watchful eye on the samples). Melt Graphs are included in all Reports

and attached to printouts for GLP validation of your analysis results.

There are several ways to display Melt Graphs:

• Touch the Graph button on the Melt screen at any time during ramping to display an

up-to-date Melt Graph for the ongoing melt.
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• Touch the Graph button on the Report screen to display the Melt Graphs

corresponding to the Report being displayed.

• Melt Graphs are included in all hardcopy printouts of Reports generated with printers

supporting graphical output.

• Melt Graphs are also available through the MeltView software data display.

The detection threshold values (Onset%, Single% and Clear%) used by the Digital Image

Processor to determine melting temperatures are user-programmable. The factory default

values loaded into your OptiMelt are generally adequate for most tests and samples,

however, fine tuning of their values might be required to better match your visual and

automated results. Follow the instructions below to view and/or modify the detection

thresholds of your OptiMelt system:

1. Touch the Setup button on the Melt screen.

2. Touch the Detection button to select Camera and activate automated determination of

melt results (factory default) if necessary.

3. Touch the Onset% button to adjust the detection threshold used by the DIP to

calculate the onset point for your samples. The factory default value is 70.

4. Touch the Single% button to adjust the detection threshold used by the DIP to

calculate the single melting point for your samples. The single point is often linked to

the meniscus point of the samples, and in that case the factory default value of 50 is

generally adequate. To link the single point to the clear point of your samples, change

the threshold value to the Clear% value.

5. Touch the Clear% button to adjust the detection threshold used by the DIP to

calculate the clear point for your samples. The factory default value is 10 and it

generally works very well for most tests and samples.



Chapter 1 Getting Started 17

OptiMelt Automated Melting Point System

MeltView Software

The sample images captured by the internal camera, and used by the Digital Image

Processor, are also available for real-time transfer to a PC over the USB interface.

Figure 13. MeltView software.

The MeltView software, available as a free download from

http://www.thinksrs.com/downloads/soft.htm, handles all image transfers, allowing

OptiMelt users to display (and store) real-time digital images of the samples on a

computer screen during analysis. All sample images transferred to the PC, are bundled

together as a single package and automatically stored on the computer’s hard disk when

the analysis is completed. This capability provides the most powerful and definitive

documentation infrastructure available from any commercial melting point apparatus.

Stored image packages may be recalled at any time and melts can be played back, frame-

by-frame or as movie, by simple moving a cursor back and forth with your mouse. Melt

Graphs are available for all saved determinations providing the most convenient path to

fine tune detection thresholds for automated determinations.

Tip
Being able to replay a test after the fact is an invaluable tool for GLP documentation, for

fine tuning of results and for laboratory demonstrations in educational settings.

MeltView Installation Steps:

1. Download the MeltView software directly from the SRS website:

http://www.thinksrs.com/downloads/soft.htm.

2. Install the software in your computer using the instructions in the Readme.txt file

included in the installation package.

3. Connect your computer to OptiMelt using a standard USB cable.

4. Launch the MeltView software.

5. Refer to the on-line help, provided with the MeltView program, for detailed step-by-

step instructions.
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Chapter 2 

Displays and Menus

The OptiMelt has a menu driven, touchscreen user interface. To activate an on-screen button, simply

touch the LCD display over the button area.

There are four main display screens – Melt, Timer, T meter and System. The Melt screen is used to

perform melting point determinations. The Timer screen is used to access the three configurable timers

built into the instrument. The T meter screen is used to display temperatures from an external

thermometer connected to OptiMelt. The System screen is used to setup various operating parameters of

such as remote interface, printing, date/time, camera alignment and temperature scale calibration.

Displays are accessed via the Tabs displayed at the top of the Touchscreen/LCD display. Within each

screen, there are specific menu buttons used to configure data acquisition and display.

Menu Buttons

The OptiMelt uses various types of buttons to navigate the menu system and enter or

change parameters.

Tabs

There are four tabs, permanently displayed on the top edge of the screen,

which are used to access the different functions of the OptiMelt: Melt,

Timer, T meter and System.

Submenu

Display a submenu. Use the submenu to access parameters that do not fit or

belong on the top level screen.

Choose

Display a multiple choice selection list. Touch an item from the list to

choose it.
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Numeric Entry

Display the numeric entry keypad. Enter a parameter value using the

touchscreen keypad, then touch [accept] to store it. Touch [cancel] to quit

entry with no change.

Text Entry

Display the text entry keypad. Enter a text string using the touchscreen

keypad, and touch [ok] to store it. Touch [abort] to quit entry with no

change.

Action

Perform the indicated action. Touch the button to perform the action

indicated. Further instructions may be presented on the screen.

Help

On-screen Help provides information on the operation of your OptiMelt. Help

Information is available for Menus, Buttons, Displays and hardware.

To display help on an item...

first... touch the Help Key on the screen. The button becomes highlighted.

next... touch the button or box you wish to learn about. The screen changes to the Help

Display Window and help text is displayed.

then... use the [up] and [down] buttons to scroll through the text. Touch [done] to return

to normal operation.

or... touch [More] for a list of related topics. Choose a topic in the list to display its

help.

then... use [back] to display previous topics and [forward] to return to later topics.

Figure 14. Help Screen.
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Tabs

There are four tabs, permanently displayed on the top edge of the touchscreen LCD,

which are used to access the different functions of the OptiMelt: Melt, Timer, T meter

and System.

Melt

Touch this tab to access the Melt screen and perform melting point determinations with

OptiMelt. This is the main function of OptiMelt.

Timer

Touch this tab to access the Timer screen and use the timing functions of OptiMelt.

OptiMelt includes three user-configurable timers which can be used to time events

around the lab while the instrument is not needed for melting point determinations.

T meter

Touch this tab to access the external temperature measurement screen and use the

OptiMelt to display temperatures sensed by an external thermometer.

OptiMelt includes an external temperature measurement facility which can be used to

monitor temperatures around the lab while the instrument is not making melting point

determinations. An external Pt RTD resistor thermometer is required to perform external

temperature measurements with OptiMelt.

Important
No T meter functions are available during a melt. The T meter Tab is not displayed

during the preheating and analysis stages of a melt.

System

Touch this tab to access the System menu.

Use the System menu to configure OptiMelt’s printer and computer interfaces, adjust the

LCD touchscreen, align the camera and calibrate the temperature scale.
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Melt Screen

Press the Melt tab to access the Melt Screen.

Figure 15. Melt Screen.

The oven temperature (°C) is prominently displayed. On-screen instructions guide you

through the analysis process.

During a melting point determination, the heating stand is temperature ramped at the

specified Rate from the Start to the Stop temperature. The heating block is automatically

cooled back to the Start temperature at the end of the analysis.

Setting up a melting point determination is very simple:

• Touch the Start button to program the Start temperature.

• Touch the Stop Button to program the Stop temperature

• Touch the Rate/min button to program the heat ramping Rate.

• Inset the capillaries and press the Heat or Start button to launch the measurement

cycle.

• Follow the on-screen instructions to complete the analysis.

Action Buttons

A single Action button, placed to the right of the Instructions area of the Melt Screen, is

used to navigate through the different stages of a melting point determination. This button

is state sensitive – it changes its appearance and functionality throughout the melt

process.

Heat

Press this button to pre-heat the oven to the Start temperature of the melting point

determination.
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Abort

Press this button to abort pre-heating.

The heater shuts down and the block cools back down to ambient temperature.

Start

Press the Start button to initiate the heating ramp for the current melting point

determination.

The heating ramp starts at the Start temperature and proceeds at the ramp Rate until the

Stop temperature is reached or the Halt button is pressed.

Halt

Press this button to halt the heating ramp and revert back to the Start temperature.

The Halt button is typically used to end the analysis when the melt is completed before

reaching the Stop temperature.

Start Temperature

Range: 30 ºC – 400 ºC

This is the temperature that serves as the starting temperature for the heating ramp during

a melting point determination.

As a general rule, sample capillaries should be introduced into the heating block after the

temperature is stabilized at the Start temperature. This is particularly critical for samples

that melt with decomposition.

The Start temperature is usually programmed 5-10 °C below the expected melting point

of the sample substance. Beware that some pharmacopeia guidelines have very specific

requirements for Start temperature settings.

OptiMelt automatically returns to the Start temperature at the end of a melt in preparation

for the next melting point determination. The heating block will only remain heated at the

Start temperature for a time equal to the Timeout programmed in the Options menu.

Note
The Start Temperature must be 10 °C above room temperature for reliable operation.
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Stop Temperature

Range:  (Start Temp+5) °C – 400 °C

This is the temperature at which the heating ramp is terminated during a melting point

determination.

At the end of the ramp, the capillaries must be discarded, the melting points are

calculated and saved and the heater stand is automatically cooled back to the Start

temperature.

Press the Halt button to interrupt the melt before the programmed Stop temperature is

reached.

Rate/min

Range:  0.1 – 20 °C/min

This is the fixed rate of temperature rise between the Start and Stop temperatures for the

heating ramp during a melting point determination.

The Ramp Rate is the most important instrumental parameter affecting the

accuracy and reproducibility of melting point measurements.

Ramp rates around 1 °C/min are reasonable for routine determinations and recommended

by most pharmacopeias. Purity determination and precision measurements are performed

at a maximum heating rate of ~0.5 °C/min, though the recommendation is to use

0.1-0.2 °C/min whenever feasible. Higher rates are only recommended for quick

determinations on substances with unknown melting points.

Samples that start to decompose at temperatures below their melting point, are usually

measured at ramp rates above 5 °C/min to avoid contamination from byproducts.

Mixed melting point determinations (described below) can be performed with ramp rates

as large as 10 °C/min.

Temperature Display

Options: Big Numbers, Trend Graph and State Icon.

The Temperature display shows the temperature of the heating stand in real time, as

measured by a fast and accurate Pt RTD resistor thermometer in close proximity to the

samples.

Touch the Temperature display to select from one of three different display options: Big

Numbers, Trend Graph and State Icon.



Chapter 2 Melt Screen 25

OptiMelt Automated Melting Point System

Big Numbers
This is the display recommended for routine determinations and when visibility of the

oven temperature is important. The large temperature numbers are easy to read from

across the room.

Trend Graph
A plot of temperature vs. time is displayed to the left of the temperature readings and

provides the recent temperature history and future trend of the heating block. This display

is very convenient to track the stability of the oven temperature during measurements.

State Icon
A small graphical representation of the heating profile is displayed to the left of the

temperature readings and provides feedback as to which stage of the melting point

determination cycle is currently underway.

Instructions Area

This area of the Melt screen displays up-to-date information and instructions during a

melting point determination.

OptiMelt guides you through the analysis process. Interactive help and timely suggestions

are also available for all important actions, functions and parameters of the instrument.

Sample Buttons (Left, Center and Right)

The sample buttons are displayed during ramping and can be pressed at any time to flag

important temperature values during a melting point determination.

Figure 16. Sample buttons while ramping.

Every pressing of the sample button is acknowledged by a distinctive beep and confirmed

by displaying the flagged temperature within the button area.

There is a dedicated sample button for each of the three capillary sample holders. The

three sample buttons are identified as Left, Center and Right in accordance to their

position within the heating block. A single beep is sounded for a Left button touch, two

beeps for a Center button and three beeps for a Right button touch. Up to six individual

temperatures can be recorded for each sample, usually associated to critical points such as
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onset of the melt, meniscus point, clear point, change in coloration, decomposition and

sublimation. All visual flags are displayed and stored in the final Test Report along with

the automated results.

Tip
During a melt determination, the user can watch the samples through the magnifying

glass, detect the physical changes as the heating ramp progresses and flag all relevant

temperature values by pressing the dedicated sample buttons, without ever looking away

from the capillaries.

Melt > Report

Report Menu 

Touch the Report button to display the Report Screen and access any of the Melt Point

Reports stored in memory. Note that the Report button is replaced by the Graph button

during a melting point determination.

Figure 17. Melt Report SubMenu

Up to eight Melt Point Reports can be stored in memory. Each Report contains both

automated and visual results for the melt as well as all relevant instrument setup

parameters and complete Melt Graphs.

The Newest Report is always shown when the Report Screen is first displayed. Use the

Select key to display previous Reports stored in memory.

Warning!
All stored  Reports are erased when the unit is turned off. Make sure you print them out

or transfer them to a PC if you need to store them permanently.

Select

Select the Report to be displayed on the Report Screen.

Select Newest to display the Report corresponding to the most recent completed melting

point determination.

Select #2 to #8 to display previous Test Reports going back in chronological order.
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Tip
Each Report is identified by a unique, incremental, identification number which cannot

be altered.

Print

Press this button to print the Report currently displayed on the Report screen.

A printer must be properly connected to your OptiMelt for this operation to be

completed.

Clear

Press this button to erase all stored Reports from memory.

Select Cancel to take no further action.

Select Clear All to complete the deletion of all stored Reports from memory.

Up/Down Arrows

Use the up and down buttons to scroll through the entire Report.

Melt > Graph or Melt > Report > Graph

Graph Display

Touch the Graph button to display a Melt Graph corresponding to (1) an active melting

point determination (from Melt Screen) or (2) a stored Melt Point Report (from Report

Screen).

Figure 18. Melt Graph Display

The Graph button is only available on the Melt Screen while a heating ramp is underway.

Touch Graph in the Melt Screen during heating  to display a real-time Melt Graph for the

ongoing melting point determination.
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Melt Graphs are stored in memory as part of the Melt Point Reports. Touch Graph in the

Report screen to display the stored Melt Graphs corresponding to the selected Report.

Cursor
Touch within the graph area to move the cursor. Touch the right half of the chart to move

the cursor to the right, the left half to move to the left. Touch close to the center to move

slowly, at the edges to move rapidly. The temperature and and relative intensity (%) at

the cursor are displayed in the boxed area above the graph.

Press Done to exit the Melt Graph display and return to the Melt or Report Screen.

Tip
Use real-time  Melt Graph displays to track the progress and detect the Halt temperature

of all your melts.

Melt > Setup

Setup Menu

Touch Setup in the Melt Screen to display the Setup Menu.

Figure 19. Melt Setup SubMenu.

Use the Setup menu to program the Digital Image Processor detection thresholds

(Onset%, Single% and Clear%), enter a Chemical name and Batch number (for reports)

and Save/Restore/Delete analysis methods.

Warning!
Changes performed within the Setup menu will affect subsequent melting point results.

Detection

Options: Visual only, Camera.

Choose between Automated and Visual-only melting point detection.

Select Camera if automated determination of melting points with the built-in camera is

desired.
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Select Visual-only if no automated determination of melting points is possible or

necessary.

Visual-only determination of melting points is recommended for samples that melt with

severe decomposition or that undergo serious and unpredictable physical changes during

the heating ramp. Examples of samples not amenable to automated determination are

samples that explode, boil away or bubble up the capillary tube. Use the sample buttons

to flag important sample changes during the melt in visual-only determinations.

Onset Threshold (Onset%)

Range: 0 to 100%, default: 70%

Select the threshold value used by the Digital Image Processor for the automated

determination of the onset point of a melt. Typical threshold values are between 60% and

90%.

Proper setting of the Onset% threshold involves carefully matching the visual

identification of the onset of the melt to the automated results for the substance being

analyzed. This is often an iterative process. Visual onset determination is affected by

subjectivity associated with the identification of subtle changes at the start of a melt, and

is also somewhat substance dependent. Onset thresholds are usually independent of ramp

rate for a given compound.

Clear Threshold (Clear%)

Range: 0 to 100%, default: 10%

Select the threshold value used by the Digital Image Processor for the automated

determination of the clear point of a melt. Typical threshold values are between 25% and

5%.

Proper setting of the Clear% threshold involves carefully matching the visual results for

the end of the melt to the automated results for the substance being analyzed. This is

generally an iterative process.

Single Threshold (Single%)

Range: 0 to 100%, default: 50%

Select the threshold value used by the Digital Image Processor for the automated

determination of the single melting point of the substance being analyzed. Typical

threshold values are between 60% and 5%.

OptiMelt users can choose to display the results of a melt as (1) a Range, or (2) a Single

number or (3) Both. Single melting point temperatures are sometimes associated with the

meniscus point, but more often to the clear point of the melt. If a Single melting point

number display is preferred, please specify whether it is the clear or meniscus point.
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Single melting point is sometimes used to represent the meniscus point and displayed

along with the melting range of substances to provide a more thorough description of the

melt.

Chemical Name

Enter a name for the chemical substance being analyzed.

The chemical name is included in the final Test Report, displayed in the Melt Instruction

area, and is also used as the filename when saving/restoring/deleting analysis methods.

Chemical Batch Number

Enter the batch/lot number for the sample being analyzed.

The batch number is included in the Test Report and displayed in the Melt Instruction

area.

Save

Save the current analysis method using the chemical name as filename.

Batch memory can store up to 24 different analysis methods.

The analysis method includes all the information required to exactly reproduce the

current determination at a later time. This includes: Start and Stop temperatures, heating

Rate, Detector, Onset%, Single%, Clear%, Chemical name and ThermoCF. Use stored

analysis methods to configure repetitive determinations.

Restore

Restore an analysis method from batch memory.

Batch memory can store up to 24 different analysis methods.

The analysis method includes all the information required to exactly reproduce a

determination at any time. Use stored analysis methods to configure repetitive

determinations.

Delete

Delete an analysis method.

Select the method to be deleted by simply touching its filename on the list.

Batch memory can store up to 24 different analysis methods
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Melt > Options

Options Menu

Touch Options in the Melt Screen to display the Options menu.

Figure 20. Melt Options SubMenu.

Use the Options menu to select common melting point measurement preferences for the

display and printout of results, audio feedback and thermodynamic and statistical

calculations.

Changes performed within the Options menu are just user preferences and will not affect

your melting point results.

Display

Options: MP range (default), Single MP and Both

Select a melting point display format for the automated results.

Select MP Range if you prefer to display a temperature range as the final result of the

automated determination. The MP range is determined by OptiMelt as the temperature

span bracketing the onset and clear stages of the melt. The onset and clear points are

calculated by the Digital Image Processor from the Melt Graph, based on the Onset% and

Clear% threshold values. No single melting point is calculated or displayed in this case.

This selection provides the most popular presentation of results for melting point

determinations.

Select Single MP if you prefer to report a single temperature as the result of an automated

melt point determination. The single point is calculated from the Melt Graph by the

Digital Image Processor based on the Single% threshold. If a Single MP display is

preferred, please specify whether it is the clear or meniscus point. Single melting point

reports are often used in quality control labs for routine determinations.

Select Both if you prefer to calculate and display both the melting point range and the

single melting point at the end of the analysis. The single point result is often associated

to the meniscus point and listed along with the melting range of the substance to provide

a more thorough description of the melt.
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Statistics

Options: Skip (default) or Calculate

Enable or disable statistical calculations on the automated results.

If enough sample is available, and three capillaries of the same substance can be analyzed

at the same time, OptiMelt can be directed to calculate the average of the three automated

determinations providing a more accurate result for the melting point temperatures.

Select Skip to disable statistical calculations on the automated results.

Select Calculate to enable statistical calculations on the automated results. The averaged

results for the three identical samples are included in the Report.

Printout

Options: Manual (default) or Auto

Choose between Manual or Automatic printout of the final Test Report at the end of a

melt.

Manual means that the user must manually display and printout Reports from the Report

screen after the melting point determination is completed.

Auto means that OptiMelt automatically prints out a Report at the end of a melting point

determination whenever a printer is connected to the instrument.

Beep

Options: Off or On (default)

Enable or disable audio beeps.

On means that distinctive beeps are sounded every time an important task is completed

by OptiMelt or user attention is required.

Off means that no beeps are sounded during the melting point analysis.

Thermo MP

Options: Skip (default) or Calculate

Enable or disable calculation of thermodynamic corrections for the melting point

determination.

Select Skip to disable thermodynamic correction calculations.

Select Calculate to enable thermodynamic correction calculations.
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The thermodynamic correction is directly proportional to the square root of the ramping

Rate, and to the Thermodynamic Correction Factor (ThermoCF) for the substance being

analyzed: T(r) = (ThermoCF) · r
1/2

.

The thermodynamic correction, T(r), is listed in the test Report and must be subtracted

from the clear point to provide an estimate of the true thermodynamic melting point of

the sample.

Thermodynamic correction factors are stored in analysis method files.

Please consult Appendix A of this manual for details on the calculation of

Thermodynamic Melting points.

Thermo Corr. Factor (ThermoCF)

Range: 0.1 to 10, default: 1.0

Enter the Thermodynamic Correction Factor for the sample being analyzed.

A substance-specific Thermodynamic Correction Factor, ThermoCF, can be programmed

into the OptiMelt and used by the instrument to automatically calculate Thermodynamic

Corrections, T(r) = (ThermoCF) · r
1/2

, at the end of each melting point determination.

Theoretically, the value of ThermoCF is related to the heat conductivity and the heat of

fusion of the substance being analyzed. It is also affected by the sample preparation

procedure and the geometry of the oven. Experimentation has shown that with OptiMelt,

a good approximation to ThermoCF is a value of 1.0. However, accurate results require

calibration. Consult Appendix A for a step-by-step calibration procedure for the

ThermoCF factor.

Thermodynamic correction factors are included in all analysis method files and displayed

in all test Reports.

Oven Off

Touch the Oven Off button to turn the oven off. The heater is turned off and the oven

cools down.

Use this button to turn off the oven at the end of your last analysis or at the end of the

day. This leaves the instrument in a safe cool state.

Timeout

Default: 00:30:00

Enter an oven timeout period.

A heated oven, idling at the Start temperature, will automatically shut down after the

specified Timeout period. This is a very useful and important safety feature built into

your OptiMelt.
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Timer Screen

Touch the Timer tab to access the Timer Screen.

Figure 21. Timer Screen.

OptiMelt includes three independent, user-configurable, countdown timers which can be

used to time events around your lab.

The timers are configured and operated using the touchscreen interface. Countdown,

Remaining and Timeout times are prominently displayed with big numbers on the left

side of the screen. Reset and Start/Stop buttons on the right side of the screen control the

timers.

Timeouts are prompted with (1) distinct beeps, (2) a switch to Timeout time display

(countup mode) and (3) dashes bracketing the Timeout times.

Timer 1
Timer 2
Timer 3

Press the Time display area of a timer to enter a new Countdown time.

Countdown times are permanently displayed on the upper right corner of the Time

display area.

All times are displayed with big numbers and alternate between:

Countdown time – displayed after a new Countdown time is programmed and when the

Reset button is pressed.

Remaining time – displayed during countdown, after the Run/Stop button is pressed.

Timeout time (bracketed by dashes, countup mode) – displayed after the Countdown time

has elapsed and until the Reset or Start/Stop buttons are pressed.
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Reset

Touch the Reset button to abort countdown and reset the Time display area to the full

Countdown time.

Run/Stop

Touch the Run/Stop button to start/stop a countdown. The Remaining time is displayed

during the countdown process, and until a timeout occurs. After timeout, the display

switches to Timeout time and starts counting up to give an indication of the time since the

timeout took place.
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T Meter Screen

Press the T meter tab to access the external temperature measurement capabilities of your

OptiMelt System.

Figure 22. T Meter Screen.

OptiMelt can be used to measure temperatures around the lab while not being used for

melting point determinations.

A back panel connector allows connection of an external 100 ,  = 0.00385 / /°C, Pt

RTD thermometer with 2, 3 or 4 wire connector configurations.

All external temperatures are displayed in degrees Celsius on the front panel of the

instrument using big numbers which can be easily read across the room.

An Alarm facility can be programmed to constantly check for high and low temperature

conditions in your laboratory providing real-time audio feedback whenever user

selectable limits are exceeded.

Long term temperature logging is available with both tabular and graphical display of the

stored data and user selectable logging interval.

OptiMelt detects the presence of an external Pt RTD probe when the T meter screen is

displayed. “RTD DISCONNECTED” is displayed instead of the temperature if a probe is

not present or is not properly connected.

Alarm

Touch this button to choose between alarm enabled or disabled.

Enabled means that the temperature readings are constantly compared against the Alarm

low and Alarm high limits, and a beep is heard every time the temperature falls out of

their range.

Disabled means that no alarms are available.
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Alarm Low

Enter the Alarm Low threshold.

If Alarm is enabled , a beep is sounded if the measured temperature drops below the

Alarm low limit.

Alarm High

Enter the Alarm high threshold.

If Alarm is enabled, a beep is sounded if the measured temperature rises above the Alarm

high limit.

Logging

Touch this button to select between temperature logging on or off.

T Meter > Table/Graph

Table and Graph

Touch the Table/Graph button to access the Table/Graph display of the logged

temperature data versus time.

   

Figure 23. T Meter Table and Graph Screens.

T Meter>Table/Graph>Setup

Setup Menu

Touch the Setup button in the Table or Graph displays to access the Logging setup menu.

Use the Logging setup menu to (1) turn logging on or off, (2) set the logging interval and

(3) clear the logging buffer.
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Logging

Touch this button to select between temperature logging on or off.

Log every

Enter the logging interval.

Choose larger logging intervals for long term logging applications.

Clear Log

Touch the Clear log button to clear the entire temperature log.

T Meter > Graph > Axes

Axes Menu

Touch the Setup button in the Graph display to change the graph parameters.

Autoscale

Touch this button to Autoscale the vertical axis.

Tmax

Enter the maximum temperature for the vertical axis.

Tmin

Enter the minimum temperature for the vertical axis.

Time Range

Enter the range of the horizontal axis.

Zoom

Zoom the horizontal axis around the cursor location.

Fullscale

Display the entire temperature log at once.

Cursor

Touch within the graph area to move the cursor.
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Touch the right half of the chart to move the cursor to the right, the left half to move to

the left. Touch close to the center to move slowly, at the edges to move rapidly.

The time and temperature at the cursor are displayed in the boxed area above the graph.
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System Screen

Press the System tab to access the System Menu

Figure 24. System Screen.

Use the System menu to test, align and calibrate important functions of your OptiMelt

including: USB interface, printer interface, touchscreen/LCD setup, date/time,

temperature scale calibration and camera alignment.

System Name

Touch this button to enter a system name for your OptiMelt.

The System name identifies the unit over the printer and USB interfaces.

Time/Date

Adjust the time and date settings of your OptiMelt.

The internal clock is used to…

• Run the built-in timers

• Time stamp Test Reports and calibrations

• Log temperatures

• Enable the backlight saver

All times are represented in 24hr format (18:30 is 6:30 pm). The clock requires manual

adjustment after daylight savings corrections take place.



Chapter 2 System Screen 41

OptiMelt Automated Melting Point System

Selftest

Touch the Selftest button to trigger the power-on test procedure. This also displays the

firmware version and serial number for your OptiMelt.

Tip
Use the System Selftest button to determine the firmware version and OptiMelt serial

number before calling the factory for customer support.

USB Q

Display the USB (Universal Serial Bus) transmit and receive buffers. OptiMelt buffers

the most recent characters received and transmitted over the interface. The queue display

shows the interface history.

The queue display may slow down communications and should be displayed only when

testing or debugging a test program.

Press the Done button to exit from this display.

The upper half of the remote queue display is the receive queue. These are the most

recent characters which have been received by the OptiMelt (displayed in UPPER case).

Commands which have already been executed are shown in normal text. Commands

which have not yet been executed are shown with a gray background. Command errors

are shown in inverse text.

The lower half of the remote queue display is the Transmit Queue. These are the most

recent characters which have been placed in the output buffer. Characters which have

already been sent over the interface are shown in normal text. Characters which are

waiting to be sent are shown with a gray background.

System > Printing

Printing Menu

Touch the Printing button to access the Printing Submenu.

Figure 25. Printing Submenu.
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The Printing submenu includes all the configuration options relevant to the printer

interface.

Text and graphical hardcopy printouts of melting point Test Reports are available from

many different printers (RS-232C serial interface) including Citizen, Epson and even

generic models. The use of high speed, dot matrix printers with graphical capabilities is

recommended for hardcopy records of your reports. A generic driver is also included for

printers not supported specifically by the OptiMelt drivers or which do not support

graphical capabilities.

Tip
Thermal and Inkjet Printers are not recommended since their records tend to fade rapidly

when exposed to ambient light. This makes them incompatible with GLP requirements.

Printer

Select a printer driver compatible with the serial printer connected to your OptiMelt unit.

Tip
Use the Test print button to validate your printer driver selection.

Select Citizen to printout results on a Citizen dot matrix printer. For example,

iDP3550-F40RFG and related models.

Select Epson to printout results on an Epson dot matrix printer. For example, TM-U220

and related models.

Select Generic to printout results on a generic serial dot matrix printer or a serial printer

which does not support graphical output.

If none of the available drivers works properly with your serial printer, consult the

printer’s User Manual and use the individual: Baud, Word Length, Parity, Flow Control

and LineFeed buttons to program your printer interface settings by hand. Most printers

also include dip switches that the user can access to adjust RS-232 settings.

Baud

Select the RS-232 (printer) interface baud rate.

The two available baudrates are 9600 (default) and 19200.

Most printers are factory set to 9600 baud rate.

Parity

Select the RS-232 (printer) interface parity.

The three options are None, Even and Odd.

None is standard for most printers.
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Test print

Touch this button to transmit the string “SRS OPTIMELT” to the printer. The text should

be automatically printed out if the printer driver is properly selected, the cables are

properly connected and the printer is turned on and on-line.

Use this button to test the integrity of your printer interface and to make sure the proper

printer driver, cable connection and settings are being used.

Flow Control

Select the RS-232 (printer) interface flow control mode.

The three options are: None, Xon/Xoff and Hardware.

None is standard for most printers. Check the printer’s manual for the type of flow

control required.

Word Length

Select the RS-232 (printer) interface word length.

The two available word lengths are 7 bits and 8 bits (default).

8 bits is factory standard for most printers.

PrinterQ

Display the RS-232 (printer) transmit queue. OptiMelt buffers the most recent characters

transmitted over the printer’s RS-232 interface. The queue display shows the interface

history.

The display includes the most recent characters which have been placed in the output

buffer. Characters which have already been sent out to the printer are shown in normal

text. Characters which are waiting to be sent are shown with a gray background.

LineFeed

Select the number of extra linefeeds required by the printer to properly space lines of text.

The options are: 1 extra or 0 extra.

The Generic printer driver defaults to 1 extra LineFeed to assure adequate spacing and

wrapping of text lines in all cases. Reduce the setting to 0 extra LineFeed if extra spacing

is observed between text lines in the Report. The linefeed setting usually requires some

testing.
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System > Screen

Screen Menu

Touch the Screen button in the Systems Menu to display the Screen Submenu.

Figure 26. Screen Submenu.

Contrast Up
Contrast Down

Adjust the screen contrast according to your viewing needs.

Align

Display the Touchscreen Calibration window.

If there is consistent misalignment between the LCD buttons and their touch sensitive

areas, follow this alignment procedure to realign the overlap between the LCD and

touchscreen.

Tip
Use the eraser on the end of a pencil to touch the screen. This ensures the best alignment

of the LCD and the touchscreen.

Test

Display the Touchscreen Test window. The cross-hairs on the screen should be aligned

under the touch point across the entire screen. If the alignment is significantly off, use the

touchscreen Calibration window to re-calibrate.

Saver

Select the Backlight Saver mode (Enabled or Disabled). The Backlight Saver extends the

life of the LCD screen backlight and the heater block illumination LEDs by turning them

off when the unit is not in use (e.g. overnight).

Disabled means that the backlight will never be turned off.
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Enabled means that when the time of day is between the Off time (evening) and On time

(morning), the LCD backlight and block illumination LEDs will turn off if the

touchscreen is not touched for a period longer than the backlight Delay. No view of the

samples is available but all other OptiMelt functions remain active while the backlight is

off.

Important
Touch the LCD screen to reenergize the backlight and illumination LEDs.

Delay

Enter the backlight Delay time.

If the backlight Saver is enabled and the time of day is between the Off time and On time,

then the display backlight turns off if the touchscreen remains inactive for the backlight

Delay time.

Off time
On time

Enter the backlight On time/Off time.

If the backlight Saver is enabled and the time of day is between the Off time and On time,

then the display backlight turns off if the touchscreen is inactive for the backlight Delay

time.

Recommendation
Set the Off time to the time at which you leave the lab at night. Set the On time to just

before your return in the morning. There is no need to keep the light on when nobody is

looking at the screen.

System > Calibrate

Calibrate Menu

Touch the Calibrate button to access the Temperature Scale Calibration Submenu.

Consult Chapter 4 of this manual for detailed information on the Temperature Scale

Calibration Procedure for your OptiMelt.

System > Align Cam

Align Cam Menu

Touch the Align Cam button to access the Camera Alignment Submenu.

Consult Chapter 4 of this manual for detailed information on the Camera Alignment

Procedure for your OptiMelt.
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Chapter 3 

Melting Point Determination

This chapter includes basic guidelines and recommendations designed to minimize errors during melting

point determinations with OptiMelt.

The factory recommended temperature scale calibration procedure is also prresented in detail.

Introduction

A few basic guidelines must be carefully followed to avoid errors during melting point

determinations with OptiMelt. The way in which the sample is prepared and the

instrument is programmed have the greatest influence on the accuracy and reproducibility

of a melting point measurement. Subjective interpretation of the changes observed in the

sample (visually and/or automatically) during the analysis can also lead to unreliable

results.

Background

The melting point of a substance is the temperature at which the material changes from a

solid to a liquid state. Pure crystalline substances have a clear, sharply defined melting

point. During the melting process all of the energy added to a substance is consumed as

heat of fusion and the temperature remains constant throughout the phase transition.

A pure substance melts at a precisely defined temperature characteristic of every

crystalline substance and dependent only on pressure (though the pressure dependency is

generally considered insignificant).

Determining the melting point is a simple and fast method used in many diverse areas of

chemistry to obtain a first impression of the purity of a substance. This is because even

small quantities of impurities change the melting point or at least clearly enlarge its

melting range. Melting point determinations are more than just a classroom exercise in

the organic chemistry laboratory, the test is still an important technique for gauging

purity of organic and pharmaceutical compounds.

The determination of melting points is one of the oldest identification and test methods

for organic substances. The melting point is easy to measure, tabulate and classify.

Extensive collections of tables give the exact values of many pure, inorganic and organic

compounds. The melting point determination is a fast and cost-effective technique and

remains a strong link to the vast pre-instrumental chemistry literature.
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Capillary Method

The procedural rules for melting point determinations are defined in the pharmacopeias.

The medical handbooks include minimum requirements for the design of the melting

point apparatus and for performing the measurements. Automated melting point

determination procedures are generally included. Very often, the pharmacopeias also list

special methods for difficult or unusual cases of melting point determination.

The pharmacopeias regard the capillary method as the standard technique for melting

point determination. In this methodology, a thin glass capillary tube containing a compact

column of the substance to be determined is introduced into a heated stand (liquid bath or

metal block) in close proximity to a high accuracy thermometer. The temperature in the

heating stand is ramped, at a user-programmed fixed rate, until the sample in the tube

transitions into the liquid state. While determining a melting point, several observations

and the temperatures in each case, are recorded.

Figure 27. Capillary tubes with solid sample.

Tips
• The metal heating stand of the OptiMelt can accommodate three capillary tubes and

up to three independent samples can be analyzed at the same time. A platinum

resistance thermometer, in close proximity to the sample slots, is used to read the

temperatures during the melt.

• Your OptiMelt includes a vial of precision melting point capillaries, specifically

designed to fit the sample slots and provide the most uniform and repeatable results.

The capillary method described by most pharmacopeias relies on a visual detection of the

melt. However, OptiMelt allows automated detection of the melting point and melting

range while at the same time providing a view of the sample during the process.

The accuracy of a melting point record is assured by: (a) careful sample preparation,

(b) proper instrument setup, and (c) routine calibration of the temperature scale against

certified reference standards.
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Sample Preparation

Careless preparation of the sample is the leading cause of inaccurate and

irreproducible results in melting point determinations.

Any substance being loaded into a melting point capillary must be (1) fully dry,

(2) homogeneous and (3) in powdered form.

Moist samples must be dried first – 48 hours over P2O5, in a dessicator, usually gets the

job well done.

The primary requirement for a good melting point determination is that the sample be in a

fine powder form. This assures efficient and reproducible heat transfer into the sample

and enhances the overall appearance of the sample for easier detection of the melt.

Coarse crystalline and non-homogeneous samples must be crushed into a fine powder in

a mortar. An agate, glass or alumina mortar and pestle are recommended.

To fill a capillary tube with a sample, the open end of the capillary is pressed gently into

the substance several times. The powder is then pushed to the bottom of the tube by

repeatedly tapping the bottom of the capillary against a hard surface (preferred method).

Alternatively, the capillary tube can be dropped onto a table through a glass tube of ~1m

in length. A sample packing wire can be used at the end to further compact the sample.

                

Figure 28. Loading a solid sample into a capillary tube, packing the tube by tapping, and using a

packing wire.

In addition to tight packing, maintaining a fixed level in the fill is also a very important

requirement. Taller samples require extra heat to completely melt and usually display

larger melting ranges than their shorter counterparts.

A sample height between 2.0 and 3.0 mm is recommended in the OptiMelt for optimum

results and reproducibility.

Tip
It is generally considered good practice to wipe the outside surface of capillary tubes with

a clean cloth before inserting them into the heating stand. Dust from dirty tubes can

slowly accumulate on the glass window of the heating block reducing overall visibility of

the melt.
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If your sample is hygroscopic, or sublimates at high temperatures, the open end of the

capillary tube must be sealed by heating. Hygroscopic samples must be stored in a

dessicator between tests, this is particularly critical in humid environments or during

rainy days.

The sample tubes are loaded into the OptiMelt by inserting them into one of the sample

position slots located on top of the instrument. Up to three samples can be accommodated

by the heating block simultaneously. Loading three capillaries with the same substance

and melting them at the same time and averaging their melting points provides the fastest

and simplest way to improve the repeatability and accuracy of melting point

determinations.

Figure 29. Loading capillaries into OptiMelt.

Tips
• Most pharmacopeias list recommended drying procedures for melting point samples

and certified reference standards.

• Make sure the OptiMelt is plugged in and set to a Start temperature below the

expected melting point of the sample(s) before placing any capillaries into the sample

slots.

• Use the same batch of capillaries for calibration and for high accuracy measurements

to assure the repeatability of results. NOT ALL CAPILLARIES ARE MADE

EQUAL!

• The standard OptiMelt package includes a vial of precision melting point capillaries

specifically designed to (1) fit the OptiMelt heating stand and (2) provide the most

uniform and repeatable results. Replacement capillaries can be purchased directly

from SRS (SRS Part# O100MPC).

• Never force a capillary into the heating block! Once the capillary is inserted into a

sample hole, it should literally drop down to the bottom of the stand.

• Some chemists choose to make their own capillary tubes. This is not recommended

for accurate and reproducible results. The use of commercial capillaries, with tight

manufacturing tolerances, is strongly recommended instead.
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• For precision measurements, the optimum filling height of 2-3 mm must be strictly

observed.

• The use of a packing wire to compact a sample can lead to excessive bubble

formation and trapping during the phase transition. Do not use a packing wire if

excessive bubble formation interferes with the detection of the meniscus and clear

points of your sample.

Tube Cleaning

Failure to clean the glass tubing before making capillary tubes is one of the chief causes

of low melting points and wide melting ranges. The presence of alkali on the surface of

the sample tubes is one of the main problems. This is generally not an issue with pre-

made, commercially available melting point capillaries.

Important
If you must make your own tubes, make sure the glass stock is cleaned by rubbing the

inside with dilute solution of a neutral detergent, rinsing with dilute (10%) HCl, and

finally rinsing thoroughly with distilled water.



52 Melting Point Determination Chapter 3

OptiMelt Automated Melting Point System

Instrument Setup

Along with proper sample preparation, careful selection of the instrument

settings is also essential for accurate and reproducible melting point
determinations.

The modern trend in melting point instrumentation is towards small aluminum ovens. A

typical oven can hold three capillaries and the thermal mass around the three tubes is very

close so that deviations as small as 0.02 to 0.1ºC (temperature dependent) are kept

between the three tubes during a melt.

The main advantage of a small metal oven is the lack of an overshoot that lets you park

the unit at a start temperature <5 °C below the expected melting point of the compound.

This makes the heating and cooling of the unit a lot faster and determinations that only

last a few minutes practical.

The prototypical pharmacopeia melting point determination procedure, followed by

virtually every modern instrument, involves four basic steps:

Step 1
The heating stand is rapidly preheated to a user-specified Start temperature, just a few

degrees below the expected melting point of the samples.

Step 2
Up to three sample capillaries are inserted into the oven and once the temperature is

stable (i.e. thermal soak), a heating ramp is launched.

Step 3
The temperature of the samples continues to rise, at the user-specified ramping Rate, until

a user-specified Stop temperature is reached. Automated and/or visual observations of the

melting point, melting range and other thermal related processes are tagged during this

time.

Step 4
At the end of the heating ramp, the capillaries are discarded and the heater stand is

rapidly cooled down back to the Start temperature in preparation for a new determination.

Figure 30. Melt Screen including Start temperature, Stop temperature and ramping Rate buttons

required to program the OptiMelt.
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Correct selection of the Start temperature, ramp Rate and Stop temperature is absolutely

essential to prevent inaccuracies due to a heat increase in the sample that is incorrect or

too fast.

Start Temperature

OptiMelt range:  30 °C – 400 °C
This is the temperature at which the sample capillaries are introduced into the heating

stand, and serves as the starting temperature for the heating ramp. The Start temperature

is usually programmed 5-10 °C below the expected melting point of the substance.

Note
The Start Temperature must be at least 10 °C above ambient temperature to assure proper

stabilization of the oven.

Ramp Rate

OptiMelt range:  0.1 – 20 °C/min, 0.1 °C/min steps
This is the fixed rate of temperature rise between the Start and Stop temperatures for the

heating ramp. User adjustable ramp Rates are standard in modern automated melting

point instrumentation.

The ramp Rate/min is the most important instrumental parameter affecting

the accuracy of melting points.

Since the melting point temperature is not measured directly within the substance, but

rather outside the capillary tube (i.e. inside the heating stand) the results are dependent on

the heating rate. The temperature in a pure melting substance remains constant until the

sample has completely melted. However, this takes a finite amount of time and the oven

temperature continues to increase according to the heating rate chosen (i.e. thermal lag).

The temperature displayed does not correspond to the exact temperature in the melting

substance but to that of the oven. Consequently, higher values are obtained where the

difference between the measured melting point and the true melting temperature is

greater the more rapid the rise in oven temperature. These heating rate dependent

temperatures are referred to as “according to pharmacopeia”. Some melting point

instruments (such as the SRS OptiMelt) can compensate for the oven ramp rate and

provide corrections for the temperature readings obtained according to pharmacopeia so

that the “true thermodynamic” melting point of a pure substance can be reported.

Misuse of fast ramp rates is the main cause of inaccuracies in melting point

measurements.

Ramp rates up to 2 °C/min are reasonable for routine determinations. Higher rates are

only recommended for quick determinations on substances with unknown melting points.

Purity determination and precision measurements are performed at a maximum heating

rate of ~0.5 °C/min, though the recommendation is to stay at 0.1-0.2 °C/min whenever

feasible. Samples that start to decompose at temperatures below their melting point, are

typically analyzed at ramp rates above 5 °C/min to avoid contamination from byproducts.
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Mixed melting point determinations (described later) can be performed with ramp rates as

large as 10 °C/min.

Tips
• Following most pharmacopeia recommendations, the heating rate should always be

included in a melting point record, along with the melting range, to enable proper

reproduction of the results.

• It is often time saving to run a preliminary (i.e. fast) melting point determination,

ramping the temperature rapidly (10-20 °C/min). After the approximate melting point

is known, a second determination is performed at a much smaller ramp rate and with

a Start temperature 5 °C below the expected melting point. Samples cannot be

remelted, a fresh capillary must be used for the second determination.

Stop Temperature

OptiMelt range:  (Start Temp+5 °C) – 400 °C
This is the temperature at which the heating ramp is terminated. At the end of the ramp,

the capillaries are discarded, the results are saved and displayed in a summary test report

and the heater stand is cooled back to the start temperature in preparation for a new

determination.

Samples cannot be remelted!! Always start a new determination with fresh

capillaries.
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Visual Observations

Several noticeable changes take place in the capillaries during a melting point

determination. Subjectivity in the interpretation of the physical and chemical changes

observed during the heating ramp can be an important factor affecting the reproducibility

of melting point results.

The following events should be noted, and their temperatures recorded, to provide a

complete record of the changes observed in the samples during the melt.

First signs of change

Record the first signs of change in the samples. Early changes may be due to:

1) loss of solvent (dehydration),

2) change in crystallization state (shriveling),

3) slow onset of decomposition (darkening or change of color)

4) condensation of solvent in the coolest points of the tube and

5) individual isolated crystals starting to melt without the liquid showing up as a

cohesive phase – i.e. Sintering Point.

Onset Point

The onset point is generally considered the “official” start of the melt: liquid clearly

appears for the first time as a separate phase in coexistence with the crystals. It must not

be confused with the “sintering point” which corresponds to just isolated drops due to a

few surface crystals melted.

Figure 31. Onset point. The onset point is also often called collapse point of the sample.
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Tips
• The onset point corresponds to the lower temperature recorded in the Melting Point

Range of a substance.

• The US and International Pharmacopeias describe the Onset Point as “the

temperature at which the column of the substance under test is observed to collapse

definitely against the side of the tube”. This is also defined as the “collapse point”.

• Simple automated systems relying on optical absorption and bulk reflection cannot

readily detect the onset of a melt. They usually report temperatures for the start of the

melt that are high compared to what is detected visually. This is because it takes a

significant change in sample appearance for the measurement to detect a change in

bulk absorption or reflection. The error in the determination of the start point leads to

a reduced melting range report which is a cause of concern in some analytical and

QC applications.

• OptiMelt can automatically detect and record the onset point of a sample. The built-

in camera is sensitive to even the slightest changes in the physical appearance of the

samples, closely matching the sensitivity of your own eyes. User adjustable

thresholds are available to carefully match the visual and automatic values of the

onset point for each substance.

Meniscus Point

The meniscus point corresponds to the stage of the melt when the meniscus of the liquid

becomes visible: there is a solid phase at the bottom and a clear liquid phase on top with a

well defined visible meniscus. This point is readily detectable except occasionally when

air bubbles from below push unmelted solid to the surface.

Figure 32. Meniscus Point.

Since the meniscus point represents the time during which liquid and solid coexist it is

often considered a good representation of the “thermodynamic” Melting Point of a

substance (i.e. especially at very low ramping rates).
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Tips
• The meniscus point is often the temperature listed in European Melting Point tables

and the preferred value of the British Pharmacopeia methodology.

• In an attempt to remove subjectivity from its detection, the Laboratory of the

Government Chemist (LGC) defines the meniscus point as “the point where a

definite meniscus is visible and there is equal volumes of solid and liquid in the

capillary”.

• The meniscus point is not specifically mentioned by the US Pharmacopeia Melting

Point methods (Method <741> of USP25-NF20). The clear point (described below) is

identified as the “melting point” of a substance instead. Notice that this is a big

difference in interpretation between the British and US Pharmacopeias.

• The SRS OptiMelt can automatically detect and record the meniscus point of a

sample. A user adjustable threshold is available to match the visual and automatic

records of the meniscus point.

• The use of a packing wire during sample preparation can lead to excessive bubble

formation and trapping for some samples. Do not use a packing wire if bubbles

interfere with the detection of the meniscus point.

Clear or Liquefaction Point

The clear point corresponds to the stage of the melt at which the substance becomes

completely liquid – no more solid is left (i.e. the last crystals are melted).

Figure 33. Clear Point.

The clear point is more dependent on the ramping rate than the onset point. In general,

the clear point increases with increasing ramping rates (see Table 1).
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Ramp Rate [°C/min] Clear Point [°C]

0.1 134.2

0.2 134.4

0.5 134.9

1 135.4

2 136.2

5 137.9

Table 1. Clear Point of Phenacetin at various ramp rates (OptiMelt System).

Tips
• The clear point record corresponds to the higher temperature recorded in the Melting

Point Range of a substance.

• The clear point is most often the single temperature melting point listed in melting

point tables.

• The clear point is the temperature most often listed in US based Melting Point tables

and the only one accepted by the US and International Pharmacopeias as the “single”

melting point of a substance.

• In an automated system, the clear point is usually identified as the temperature at

which the last change in detected signal is observed during the melt.

• Simple automated systems relying on optical absorption and bulk reflection give a

number that is best correlated to the clear point.

• The SRS OptiMelt can automatically detect and record the clear point of a sample. A

user adjustable threshold is available to match the visual and automatic records for

the clear point.

Last Signs of Change

Any changes in the sample composition, before, during and after the clear point should

also be manually tagged if detected. Common events include:

Sublimation
Crystals appear in the protruding part of the glass tube.

Decomposition
Sample bubbles or changes in color during and after the melt.
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Melting Point Range

In a dynamic melting point determination, where true equilibrium between solid and

liquid phase is never achieved, the Melting Point Range – defined as the interval between

the onset and clear points – is a valuable indicator of purity of a solid compound.

The Melting Point Range is the most popular melting point record listed in scientific

papers, standard procedures, reference tables and melting point standards. It is always

advantageous to record the entire melting range of a substance, especially with

(1) unknown or new compounds, (2) impure samples, (3) mixtures with large melting

intervals and (4) polymorphous compounds. The observed range is an aid in identifying

the substance and drawing conclusions about purity and heat stability.

Reporting the melting range: [onset point, clear point] of a solid sample,

along with the ramping rate, is the preferred way to report the results of a

melt, and is much more reliable than a single number report.

If a single temperature must be used, please specify whether it represents

the clear or meniscus point.

The ramping rate affects the melting point range record, and must always be specified for

full compliance with GLP specifications.

Ramp Rate [°C/min] Onset Point - Clear Point [°C] Temp. Range [°C]

0.1 133.7-134.2 0.5

0.2 133.8-134.4 0.6

0.5 134.0-134.9 0.9

1 134.1-135.4 1.3

2 134.3-136.2 1.9

5 134.9-137.9 3.0

Table 2. Melt Point Range of Phenacetin at various ramp rates (OptiMelt System).

Notice the larger effect of ramping rate on the clear point than on the onset point.

The sample height inside the capillary also affects the melting point range. Since the

temperature displayed by the melting point apparatus does not correspond to the exact

temperature in the melting substance but to that of the oven, higher clear point values are

obtained for taller samples. The sample height recommended for the OptiMelt systems is

2-3 mm. Deviations from the recommended value can lead to errors in the clear point

determination beyond the accuracy specifications of the instrument.

Tips
• The SRS OptiMelt can automatically detect and record the onset and clear points of a

sample. User adjustable thresholds are available to match the visual and automatic

values for both points.
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• A large majority of pure organic compounds melt neatly within a range of 1.5 ºC or

melt with decomposition over a narrow range of temperature (~2 ºC) at heating rates

below 2 ºC/min. Many organic compounds, melt with decomposition over a

considerable range of temp: amino acids, salts of acids, salts of amines,

carbohydrates, etc.

• Impure substances (i.e. mixtures) melt over a larger temperature range.

Summary Report

A complete melting point report should include enough information to make it possible

for somebody else to reproduce the determination and compare results. Very useful

reporting guidelines, compatible with modern GLP requirements, were set forth by Carter

and Carter (J. Chem. Ed., 72 (1995) 647) and are listed here:

• Report all instrument settings, especially heating rate, so they can be duplicated or

reasonable adjustments made.

• Report onset and clear point temperatures to the nearest 0.1 °C (or at least 0.5 °C) for

routine melting point ranges.

• Report onset, meniscus and clear point to nearest 0.1 °C for important melting point

ranges, such as those of new compounds.

• If a single temperature is to be reported as the melting point (not recommended)

specify whether it represents the meniscus or clear point.

• Use well known melting point standards (i.e. certified reference standards) for

calibration.

Tips
A summary report is automatically generated by the OptiMelt system at the end of each

analysis. The report includes all manual and automated records collected throughout the

test, as well as all setup and calibration information required for proper certification of

the results. Touch the Report button on the Melt Screen at any time to access the last

eight Reports stored within your OptiMelt system.

Reference Tables

There is often some uncertainty as to what really is tabulated in melting point tables,

especially when a single temperature is listed for a substance.

This confusion is based on the fact that while most chemists use the clear point to report

the melting point temperature of their samples, others prefer the meniscus point. The

meniscus point is often regarded as closer to the true thermodynamic value, since it

corresponds to a coexistence of liquid and solid in the capillary, and is favored by some

scientists. However, there is no real thermodynamic justification for that assumption.

Luckily, the difference between the two temperatures (clear vs. meniscus point) is, in

most cases, very small and within the accuracy of most determinations.
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Melting Point Depression

Mixtures of substances, whose components are insoluble in each other in the liquid

phase, display a melting point depression and, instead of a sharp melting point, a melting

range (interval).

The size of the melting point depression depends on the composition of the mixture. The

depression in melting point is used for determining the purity and identity of compounds.

Rule-of-thumb
1% of a foreign substance will result in a 0.5 °C depression.

This is the main reason why recording the melting point range is the preferred record of a

melting point determination, and more useful than a single temperature report.

A wide melting range usually indicates that a substance is impure, but it may also result

from the fact that the pure substance undergoes some decomposition prior to reaching its

melting point. Pure substances that decompose during heating form a mixture of the

parent substance and the byproducts and will also show a melting range. In some cases,

the material undergoes a slight liquefaction and contraction at a temperature below the

true melting point, in others, the material may decompose and discolor so badly that a

definite melting point cannot be observed.

Purity Tracking

The phenomenon of melting point depression can be applied to the evaluation of purity of

synthetic products.

In preparative organic chemistry the purity of a substance often has to be evaluated

without a pure reference sample being available. This is the case, for example, when a

new chemical compound is synthesized. The raw product is generally subjected to a few

recrystallization steps and the melting point is determined at each stage. The onset point

continues to increase, and the melting range continues to decrease, until the substance is

either pure, or as pure as it is going to get through the purification method being applied.

Tips
• It is common practice to recrystallize synthetic products of reactions until no more

changes are detected in their melting point range.

• Careful reproduction of the sample preparation procedure is essential during Purity

tracking determinations.
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Mixed Melting Point

If two substances melt at the same temperature, a mixed melting point

determination can reveal if they are one and the same substance.

The phenomenon of melting point depression can be applied to the identification of

unknown pure substances. For example, if you measure the melting point of a sample at

160 °C, you will find from the melting point tables that this is the melting point for

several different reference compounds. The substance can be identified by determining its

mixed melting point – the sample is mixed one-by-one with small amounts of the

references and the mixed melting point is determined in each case. Whenever the melting

point of the sample is depressed by mixing a small amount of a reference with it, the two

substances cannot be identical. If, however, the melting point of the mixture does not

drop, the reference substance that was added was identical to the sample – i.e. the sample

has been identified.

The mixed melting point technique is the main reason why all high quality melting point

measurement systems can accommodate a minimum of three capillaries in their heating

blocks.

In its most common implementation three melting points are determined: (1) sample,

(2) reference and (3) reference:sample :: 1:1. If the melting point of the mixture remains

the same, then the two substances are identical. If the melting point is lowered then they

are two different substances.

Tips
• The requirements for precision and reproducibility are not as high here as when doing

a high precision single melting point determination. Heating rates as large as

10 °C/min are acceptable.

• A few pairs of substances show no melting point depression when mixed, but more

frequently the failure to depress may be observed only at certain compositions. It

requires little additional effort to measure the melting point of several compositions:

Typically a 20/80, 50/50 and 80/20 % mixture of sample and reference is prepared

and the three tubes are run in the melting point apparatus. If the three melt at the

same temp it is very likely the two compounds are one and the same.
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Chapter 4 

Maintenance and Calibration

This chapter includes basic guidelines and recommendations designed to keep your OptiMelt unit in fully

operative conditions. This includes cleaning of the unit, checking for any damages and periodic

calibrations of the temperature scale and camera alignment.

Temperature Scale Calibration

Before any melting point apparatus is put into operation, its temperature scale must be

properly calibrated using reliable reference substances with melting points that are known

exactly.

Analytical quality control (QC) laboratories must test their melting point instrumentation

on a regular basis against Certified Reference Standards (CRSs), to determine the

acceptability of their instruments according to specific QC requirements set forth by

local, national and international standards and pharmacopeia laboratories.

The temperature scale calibration of the OptiMelt system should be checked, and

readjusted if necessary, every six months (minimum) to maintain the instrument within

its accuracy specifications. (The aging of Pt/RTD resistor thermometers has been well

documented in the engineering and scientific literature and is the leading cause for loss of

accuracy in most modern melting point instrumentation.)

A three-point calibration procedure is required to check the OptiMelt's temperature

scale between 40 °C and 300 °C. The melting points of three melting point standards are

individually measured and then compared against their nominal (certified or assigned)

values. If the two sets of numbers (i.e. measured vs. nominal) deviate from one another

beyond the accuracy of the instrument, the temperature scale must be recalibrated using

the Calibration Menu built into OptiMelt. Note that no good melting point standards are

available for temperatures above 300 °C- visual determinations are recommended in that

case.

CRS Kit- O100MPS

A CRS Kit, SRS Part#O100MPS, traceable to WHO International Pharmacopeia

reference substances (see Appendix B), is available directly from Stanford Research

Systems and is recommended for temperature scale calibration and for determination of

acceptability of your OptiMelt system.
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Substance Start/Stop * (°C) Clear Point (°C ) Analysis Method

Vanillin 78/88 83.0 Vanillin

Phenacetin 131/141 135.9 Phenacetin

Caffeine 232/242 237.0 Caffeine

* Ramping rate is 1°C/min for the three compounds.

The three reference substances included in the O100MPS CRS Kit were carefully

selected to match the calibration requirements of your OptiMelt system. For convenience,

Analysis Methods for the three CRSs (labelled Vanillin, Phenacetin and Caffeine,

respectively) are factory preloaded into every OptiMelt system.

Step-by-step calibration procedure

The instructions detailed in this section correspond to a three-point Temperature Scale

Calibration procedure based on the O100MPS CRS Kit, available directly from Stanford

Research Systems or from your local representative (see Appendix B for details).

The clear points of the three CRSs are individually measured and used to check the

temperature scale of your OptiMelt system. If the measured melting points deviate from

their known (certified) values, beyond the specified accuracy of the instrument, the

temperature scale of the instrument must be recalibrated. A Calibration Menu (in the

System Menu) facilitates adjustment of the temperature scale if necessary.

Step 1
Collect the sample preparation information for the three CRSs included in your

calibration kit. Look specifically for information on: sample pretreatment, drying

agents/procedures, grinding, capillary configuration and sample loading.

Starting with the lowest melting point compound (Vanillin 83 °C)…

Step 2
Select the proper Analysis Method from the Setup submenu/Restore of the Melt Screen

or manually set the Start temperature 5 °C below the certified clear point for the standard

substance. Preheat the oven to the selected temperature.

Step 3
For manual configurations, set the ramping rate to 1 °C/min and the Stop temperature

5 °C above the clear point of the standard substance.

Step 4
Three measurements must be carried out simultaneously for each CRS. Load three

capillaries with a 2–3 mm column of the CRS and insert the tubes into the three sample

slots of the OptiMelt heating stand.
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Tip
To increase the reproducibility of results, load the capillaries using the same grinding,

loading and compacting techniques used for your routine melting point determinations.

Step 5
Perform a melting point determination on the three identical samples.

Step 6
Using the sample buttons on the touchscreen LCD, record manual entries for the

temperatures corresponding to the onset and clear points during the melt.

Step 7
Once the Report is generated, compare the results for the three capillaries against each

other. All clear point temperatures must fall within +/-0.3 °C of each other to be

considered acceptable. Repeat the measurement if a larger spread is observed being

specially careful to prepare all capillaries in the same way. Consult the factory for

additional recommendations if no improvement is detected.

Tips
Whenever possible, use the MeltView software to visualize the melts and to store a

complete digital record of the melt. The ability to replay a melt on a computer screen is

not only important to fine tune your observations, but also to provide proper

documentation in accordance to GLP guidelines.

A spread in melting point values between the three sample slots larger than +/-0.3 °C,

could be symptomatic of a heating asymmetry in the oven. However, it is most often

caused by subtle differences in sample packing, sample heights and sample placement in

the slot.

Step 8
Compare the automated results listed in the Report against your visual records. If the

automated values differ from your manual entries beyond the specified accuracy limits of

the OptiMelt, adjust the Digital Image Processor (DIP) threshold (Onset% and Clear %)

to better match both sets of numbers. Repeat the melting point determination and readjust

the DIP thresholds (i.e. iterative process) until the visual and automated melting point

measurements agree within the accuracy of your instrument.

Tips
Use the Melt Graphs, stored within each Report, to fine tune the detection thresholds.

Step 9
Check the melting point ranges [onset point, clear point] collected and make sure they are

within 2 °C.

If the measured melting ranges exceed 2 °C, check the ramping rate and the sample

preparation procedure to eliminate any potential experimental errors and repeat the



66 Maintenance and Calibration Chapter 4

OptiMelt Automated Melting Point System

determination if necessary. If no improvement is observed (within the accuracy of the

OptiMelt), consult the factory for additional information.

Tip
Typical melting ranges for pure susbstances melted at 1 °C/min ramping rates are around

1.25 ± 0.25 °C.

If melting point ranges larger than the expected values are observed, and no sample

contamination is suspected, a malfunction of the instrument should be suspected and the

instrument should be shipped back to the factory for service. Contact the factory or your

local representative for return information.

Step 10
Repeat Steps 2 thru 9 with the two remaining CRSs.

Step 11
Compare the measured clear points for the three CRSs against their nominal values.

1) If the measured clear points fall within the accuracy specifications of your OptiMelt

(see table below), no calibration adjustment is necessary. The OptiMelt is acceptable

for use as is and this is the end of this calibration procedure.

2) If the clear point for any CRS differs from its certified value, by more than the

published accuracy specification of the OptiMelt (see table below), it will be

necessary to correct the temperature scale of your OptiMelt using the Calibration

Menu described in the next section.

OptiMelt Temperature Accuracy

Melting Point Accuracy

<100 °C ± 0.3 °C

100 - 250 °C ± 0.5 °C

>250 °C ± 0.8 °C

Calibration Menu

A Temperature Scale Calibration Menu accessible from the System Menu of your

OptiMelt facilitates correction of the temperature scale in the field.

A three-point calibration (described above) must first be performed to check the accuracy

of temperature scale between 40 and 300 °C. The melting points of three CRSs are

measured and then compared against their nominal (certified or assigned) values. If the

two sets of numbers (measured vs. nominal) deviate from one another beyond the

accuracy of the instrument, the temperature scale of the instrument must be corrected

using this Calibration Menu.
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To correct the temperature scale of your OptiMelt System:

1) Touch the System Tab to access the System Menu.

2) Touch the Calibrate button to enter the Temperature Scale Calibration Menu.

3) Enter the nominal (certified or assigned) clear points for the three standards

using the Nom Low, Nom Mid and Nom High buttons. Notice that the

nominal clear points for the O100MPS standards (Nom Low: 83.0, Nom Mid:

135.9 and Nom High: 237.0) are factory loaded and do not need to be typed.

4) Enter the corresponding measured clear points for the three standards using the

Meas Low, Meas Mid and Meas High buttons.

5) Press the Calibrate button to correct the temperature scale. A confirmation

window immediately pops up offering three choices: (1) Press Calibrate to

confirm your choice and correct the temperature scale, (2) press Factory to revert

to the original factory calibration of the instrument or (3) press Done to abort the

calibration procedure without any changes taking effect.  The last temperature

scale calibration date is included in all reports as part of GLP certification. The

calibration is considered valid for a period of 6 months.

Tip
No adjustment of the Temperature scale takes place if the nominal and measured

temperatures agree for the three samples or if the Done button is pushed in the pop-up

window.

Recommendations and Tips

The accuracy of the melting point determinations performed with your OptiMelt is only

as good as the last calibration and ultimately only as good as the accuracy of the

calibrants used.

Attempts to cover the entire range of room temperature to 400 ºC with any automated

melting point apparatus combined with calibration curves often fail, and as a result, most

automated systems function with temperatures under 300 ºC, or quote larger errors at

>300 ºC. Visual inspection is recommended for all substances that melt at >300 ºC.

It is not unusual to see differences between the results obtained for the same compound

from liquid bath and metal ovens. This discrepancy is generally understood and accepted,

and rarely exceeds the uncertainty of the measurement. A slight difference is to be

expected, and is rarely beyond the accuracy of the standards.

Use visual (automated) results during the calibration procedure if visual (automated)

melting point determinations are routinely used for testing.

Whenever possible, use the MeltView software package to visualize the melts and to

store a record of the melt process. Being able to replay a melt is not only important to

improve the accuracy of your calibration, but also to provide documentation conforming

to GLP requirements.

A list of compounds commonly used as Melting Point Standards is included in Appendix

B of this manual.
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Camera Alignment

The digital camera used for automated melting point determinations faces the capillaries

and relies on a simple optical system to magnify the images of the samples. The digital

images collected during temperature ramping are analyzed in real time by the Digital

Image Processor (DIP). The DIP relies on camera alignment information, previously

stored in the OptiMelt’s memory, to zoom in on the area of the images where the samples

are located.

Stable optical alignment between the heating block and the camera  is essential for

accurate and reproducible automated results. If the mechanical alignment between the

heating block and the camera changes for any reason, the position of the samples within

the digital images will shift and the effectiveness of the DIP algorithms can be

compromised.

It is important to update the camera alignment information stored in the
OptiMelt’s memory on a regular basis. This becomes particularly important

after the heating block is moved, cleaned or repositioned.

In order to update  the camera alignment information, the following steps must be

followed:

1. Insert three sample tubes, with at least three millimeters of white powder into the

sample slots. Any substance will do as long as it is white.

2. Press the System Tab to access the System display.

3. Press the Align Cam button to trigger the Camera Alignment procedure.

4. A confirmation window immediately pops up which offers three choices: (1) Press

Calibrate to confirm your choice and update the camera alignment information, (2)

press Factory to revert to the original factory calibration of the instrument or (3) press

Done to abort the calibration procedure without any changes taking effect.  The last

camera alignment date is included in all reports as part of GLP certification.

Replacement of Faulty LEDs

Internal lighting of the heating block is provided by high brightness white LEDs with

expected lifetimes in excess of 50,000 hours. This is a significant improvement over

traditional incandescent light bulbs which usually have lifetimes well below 5,000 hours

and are sensitive to shock or vibrations.

In case of a fault, the LEDs must be replaced at the factory.



Chapter 3 Maintenance and Calibration 69

OptiMelt Automated Melting Point System

Cleaning

The housing of your OptiMelt system is coated with paint and should only be cleaned

with a rag moistened in soapy solution. Do not use halogenated solvents, acetone
or any similar solvents to clean the magnifying lens.

Remove the glass window from the heating block periodically and wipe it clean with

alcohol or acetone. Replace the window with a new one if it will not come completely

clean.

Tip
Use the image display provided by the MeltView software to test the quality of your

detection setup and to visualize the quality of the images available to the DIP.

Broken Capillaries

Immediately remove all broken capillaries and capillary pieces from the heating block.

Wait for the heating block to cool down before touching it. Remove the block

from its compartment to clean it. Loosen the two thumbscrews securing its base to the

bottom of the box and pull on the block assembly to bring it out of the box. Use a thin

cotton swab, dipped in alcohol or similar solvent, to clean the capillary slots if necessary

(careful, do not drip solvent on the exterior paint). Air dry the block before inserting it

back into the box. Tighten the thumbscrews to assure proper optical alignment of the

samples relative to the camera. Perform a camera alignment procedure after each block

cleaning procedure.



70 Maintenance and Calibration Chapter 4

OptiMelt Automated Melting Point System



Pharmacopeia vs. Thermodynamic Melting Points 71

OptiMelt Automated Melting Point System

Appendix A 

Pharmacopeia vs. Thermodynamic

Melting Point Determinations

Pharmacopeia Melting Point

The procedural rules for melting point determinations are defined in the pharmacopeias.

The medical handbooks include minimum requirements for the design of the melting

point apparatus and for performing the measurements. Automated melting point

determination procedures are generally included. Very often, the pharmacopeias also list

special methods for difficult or unusual cases of melting point determination.

The pharmacopeias regard the capillary technique as the standard method for melting

point determination. In this method, thin glass capillary tubes containing packed samples

of the substance are introduced into a heating stand that is continuously being heated up.

The capillary technique is the standard method used for melting point

determinations in most organic and pharmaceutical chemistry laboratories.

The procedures for melting point determinations in the pharmacopeias call for a fixed

rate of temperature rise in the “heating stand” (liquid bath and/or metal block), typically

between 0.2 and 2 °C/min, within a temperature range that brackets the expected melting

temperature of the compound. The oven continues to heat at a constant rate until the

sample is completely melted – i.e. clear point. In determining the melting point – the

temperature on the thermometer at the clear point (and/or sometimes at the meniscus

point) is recorded. This is not the temperature of the sample itself, but rather that of the

heating stand where the thermometer is located – i.e. the temperature is determined by

the heating medium.

When different heating rates are used for determining the melting point of a sample, the

values obtained for the clear point are dependent on the temperature ramping rate.

Because the heat transfer from the heating stand to the sample cannot be increased

proportionally to the temperature ramping rate, the temperature in the heating stand rises

to a higher level with faster rates of heat increase than it does with lower rates. As a

result, the faster the temperature is ramped, the higher the clear points are found to be.

Due to this dependence on heating rate, measurements taken for melting points are

comparable with one another only if they were taken using the same ramping rates. Any

variance from the temperature ramping rates specified by pharmacopeia procedures must

be properly recorded for Good Laboratory Practice documentation.
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Table 3 is an example of the dependence of the clear point determination on ramping rate

for phenacetin samples (MP: 134 ºC) analyzed with an OptiMelt system. As expected, the

clear point increases with increasing ramping rates. The need to specify ramping rates

along with the results of the melt is demonstrated by this data.

Ramp Rate, r [°C/min] Clear Point [°C]

0.1 134.2

0.2 134.4

0.5 134.9

1 135.4

2 136.2

5 137.9

Table 3. Clear Point of Phenacetin at various ramp rates.

The heating stands used by commercial melting point apparatuses are divided into two

categories:

Liquid Bath
The capillaries are immersed in a liquid bath (typically silicone oil) that is continuously

being heated up.

Metal Block
A small, dry thermal block (metal oven) has proven to be a good alternative to a liquid

bath.

The melting point procedures described in early pharmacopeias were designed for “liquid

bath” heating stands; however, in recent years most monographs have been updated and

supplemented to include the more prevalent metal block setups.

Tip
A slight drift in melting point results is expected when the temperatures obtained with a

liquid bath oven are compared to those obtained with a metal block stand. This difference

is to be expected and generally ignored since it most generally falls within the intrinsic

uncertainty of the measurement.
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Thermodynamic Melting Point

The transition from solid to liquid does not take place instantaneously – it requires a

finite amount of time. The melting process begins at the point where the first particles of

the bulk substance turn into the liquid state – the onset point. The end of the melt is

reached when the last solid particles have gone over into the liquid phase – the clear

point. During the entire melting process of a pure compound: (1) the temperature of the

pure substance remains constant (thermodynamic melting point) while (2) heat is

constantly transferred from the heating stand to the sample and (3) the heating stand itself

experiences a range of temperatures that depends on the selected heating rate.

When determining the melting point according to the US or International Pharmacopeias,

the temperature of the heating stand at the end of the melt (clear point) is read. That

single temperature record depends on the temperature ramping rate, it ignores the range

between the start and the end of the melt and it is not the “true” thermodynamic melting

point of the pure compound.

Figure 34. Graphical representation of the thermodynamic correction

Figure 34 is a simple representation of the sequence of events that take place during the

melting of a pure substance. At the start of the melting (time = t0), the block and the

sample are at approximately the same temperature. As soon as the melt starts the sample

temperature stabilizes while the block continues heating up. As the melt progresses, the

sample remains at constant temperature (thermodynamic melting point, MPthermo) while

the block continues to heat up. Heat is constantly transferred from the block to the sample

at a rate that is proportional to the temperature difference between the sample and the

block. The temperature of the block at the end of the melt (time= tf) is recorded as the
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clear point (pharmacopeia melting point, MPpharma). The thermodynamic correction is

defined as:

( ) thermopharma MPMPrT = (eqn. 1)

and must be expresed as a function of the ramping rate, r.

In order to obtain the thermodynamic melting temperature of a pure substance, it is

necessary to calculate and subtract a thermodynamic correction from the detected clear

point. This calculates back to the temperature at the beginning of the melt, so that the

value obtained has virtually no dependence on the temperature ramping rate.

Instruments with automated melting point determination facilities (such as OptiMelt),

often pack enough data analysis infrastructure to automate the thermodynamic correction

procedure: (1) the clear point is accurately identified and recorded, (2) the ramping rate is

known and carefully controlled, and (3) the thermodynamic correction algorithm can be

programmed and stored in memory. Knowledge of the functional dependence of the

thermodynamic correction, T(r), on r is the only requirement to automate the

thermodynamic correction process. A parametric derivation of that functional dependence

is presented in the following section.

Thermodynamic Correction

At any given time, t, during a melt, the amount of heat, dQ(t), transferred from the

heating stand to the sample during a time dt is:

  
dQ t( ) = T MP

thermo( ) dt (eqn. 2)

where,

T is the temperature of the heating stand, [°C]

t is the time variable, [min]

 is the heat transfer constant for the melting point apparatus, [calories/(°C ·
 
min)]

r = dT/dt is the temperature ramping rate of the instrument, [°C/min].

Substituting dt with dT/r in eqn. 2, leads to:

( )
( )

dT
r

MPT
tdQ thermo= (eqn. 3)

Integration of the heat transferred from the block to the sample, over the entire melting

process, provides the “heat of fusion” of the sample, Hf [Calories], which is dependent

on its mass but independent of the ramping rate, r:

( )
dT

r

MPT
H

pharma

thermo

MP

MP

thermo
f = (eqn. 4)

Calculation of the integral term leads to the analytical expression:
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( )2thermopharmaf MPMP
2r

H = (eqn. 5)

which can be rearranged to provide an equation for the thermodynamic correction:

( ) ( ) rThermoCFr
H2

MPMPrT 1/2

1/2

f
thermopharma === (eqn. 6)

According to eqn. 6 the thermodynamic correction is directly proportional to the square

root of the ramping rate, and in order to calculate the thermodynamic melting

temperature, it is necessary to know the value of the Thermodynamic Correction Factor,

ThermoCF, for the melting point apparatus:

( ) rThermoCFMPrThermoCFMPMP clearpointpharmathermo )(== (eqn. 7)

The above theory indicates that the value of the thermodynamic correction factor,

ThermoCF, depends, among other things, on the (1) heat of fusion of the sample, (2) the

thermal conductivity of the sample, (3) the thermal conductivity of the glass capillary,

(4) the sample preparation/packing method, (5) sample size and (6) the geometry and

construction of the oven. In practice, the value of ThermoCF is both compound and

instrument dependent and must be calculated through empirical determination.

Thermodynamic Correction with OptiMelt

A user programmable Thermodynamic Correction Factor, ThermoCF, can be

programmed into the OptiMelt and used by the instrument to automatically calculate

Thermodynamic Corrections, T(r)= (ThermoCF) r1/2
, at the end of a melting point

determination.

Tips
• Thermodynamic corrections are appended to melting point reports if Thermo MP is

set to Calculate in the Options menu of the Melt Screen.

• Use the ThermoCF menu button, in the Options Menu of the Melt Screen, to program

the value of ThermoCF for the compound being measured.

• Compound specific thermodynamic correction factors can be stored within the

analysis methods saved to memory.

• Use the Thermodynamic Corrections calculated by your OptiMelt to correct “ramp-

dependent” clear points (manual or automatic) and to obtain a true thermodynamic

melting point for your samples – independent of the rate of heat rise used.

• Empirical measurements have shown that in most cases a good approximation to the

Thermodynamic Correction Factor, ThermoCF, for the OptiMelt is a value of ~1.0,

when r is expressed in standard units of [°C/min].

• Calculation of your sample’s Thermodynamic Correction Factor, ThermoCF, is

recommended when accuracy is required. See the next section for details.
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Calculation of Thermodynamic Correction Factor

The Thermodynamic Correction Factor, ThermoCF, is compound specific and depends

on several factors:

• Specific heat of fusion of the sample

• Amount of sample

• thermal conductivity of the sample

• thermal conductivity of the glass capillary

• sample preparation method

• geometry of the oven

Experimental measurements have shown that in most cases a good approximation to the

Thermodynamic Correction Factor, ThermoCF, for the SRS OptiMelt is a value of ~1.0,

when r is expressed in standard units of [°C/min]. However, empirical calculation of the

Thermodynamic Correction Factor is recommended when more accurate results are

required for a specific compound.

A step-by-step calculation procedure is described below:

Step 1
Perform complete pharmacopeia melting point determinations on your sample at six

different temperature ramping rates: 0.1, 0.2, 0.5, 1, 2 and 5 °C/min.

• Three samples are analyzed simultaneously for each ramping rate: Load three

capillaries with a 2–3 mm column of sample, and insert the tubes into the three

adjacent sample slots of the OptiMelt oven.

• To increase the accuracy of results, load the capillaries using the same grinding,

loading and packing techniques used for routine melting point determinations. Keep

all sample heights between 2–3 mm.

• For each ramping rate, average the detected “clear points” (according to

pharmacopeia) for the three samples to obtain the recorded value.

• To increase the accuracy of results, use manual (automatic) clear point readings if

manual (automatic) determinations are routinely performed in the lab.

Step 2
Plot the resulting clear point records versus the square root of their corresponding

temperature ramping rate (MPpharma vs r1/2
) – a linear dependence should be observed.

Calculate the slope of the straight line, and program the result into the Thermodynamic

Correction Factor, ThermoCF, of your OptiMelt.

Step 3
Use the Thermodynamic Correction Factor to calculate the thermodynamic melting point

of the sample from the measured clear points (eqn. 7). An agreement within the accuracy

of measurement should be observed for all calculated thermodynamic melting points.

An example of this calculation procedure is included below.
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ThermoCF Calculation Example

In order to demonstrate the simplicity of the calculation procedure described in the

previous section, a series of melts were performed on a phenacetin sample with ramping

rates 0.1, 0.2, 0.5, 1.0, 2.0 and 5.0 °C/min.

Figure 35 summarizes the results and shows the expected linear relationship between the

clear point determinations and the square root of the ramping rate. The slope of the

straight line corresponds to a thermodynamic correction factor, ThermoCF= 1.9 for

phenacetin samples.
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Figure 35. “Clear point temperature vs. square root of ramping rate” for a phenacetin sample

melted at 0.1, 0.2, 0.5, 1.0, 2.0 and 5.0 ˚C/min. The slope of the straight line, ThermoCF=1.9, is

programmed into the OptiMelt as the thermodynamic correction factor, ThermoCF, for this

compound.

Table 4 demonstrates the use of the thermodynamic correction factor to calculate the

thermodynamic melting point of a phenacetin sample. In contrast to the clear point

results, and within the accuracy of the measurement (±0.3 ºC), the thermodynamic

melting point results are independent of the ramp rate as expected.
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Ramp Rate, r

[°C/min]

Clear Point [°C]

(MPpharma)

MPtherm = MPpharma –ThermoCF . r1/2

[°C]

0.1 134.2 133.6

0.2 134.4 133.4

0.5 134.9 133.6

1 135.4 133.5

2 136.2 133.5

5 137.9 133.6

Table 4. Clear and Thermodynamic Melting Point of Phenacetin at various ramp rates

(ThermoCF = 1.9).

Tip
Thermodynamic corrections, T(r), are automatically appended to melting point reports

if Thermo MP is set to Calculate in the Options menu of the Melt Screen.
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Appendix B 

Melting Point Certified Reference

Standards

What is a Certified Reference Standard?

Certified Reference Standards (CRSs) are high-purity chemicals certified by National,

Local or International Standards Laboratories and Pharmacopeia Conventions, produced

and tested according to well established and easy-to-reproduce procedures.

Use CRSs for calibration and determination of acceptability of melting point instruments

including OptiMelt.

General Guidelines and Recommendations

• Use CRSs obtained from reputable Standards and Pharmacopeia Laboratories.

• Use CRSs with Certificates of Measurement including records of:

(1) Lot/Batch Identification number (for traceability)

(2) Purity specification (analysis method, purity levels, etc.)

(3) Detailed description of the instrumental setup used for the melting point

determination: type of instrument, manual or automatic detection, hot bath or

metal block oven, capillary tube dimensions, amount/height of sample packed,

compaction method, etc.

(4) Preconditioning of the sample (i.e. drying, grinding, etc).

(5) Detailed heating conditions, including initial temperature, ramping rate and any

special comments required to properly reproduce the melting conditions used by

the standards laboratory to certify the compound. Alternatively, a reference to a

standardized melting point determination method must be included.

(6) Melting points and melting point ranges with well characterized uncertainty

errors.

• Whenever possible, choose the CRSs with the smallest uncertainty errors. Remember

that the accuracy of your OptiMelt is only as good as the accuracy of the standards

used for its temperature scale calibration. Note: As a general rule, avoid CRSs

leading to uncertainty errors larger than 0.5 °C.

• Do not assume that a CRS compatible with one specific pharmacopeia procedure is

compatible with the requirements of a different pharmacopeia protocol. For example,
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it is best to obtain CRSs directly from the US Pharmacopeia Convention in order to

determine the usability of the OptiMelt according to US Pharmacopeia protocols.

• Beware of Standards Laboratories offering CRSs compatible with multiple

pharmacopeias. Ask for samples of Certificates of Measurement before ordering

standards to assure the compatibility of their records with the pharmacopeia protocol

you plan to follow. Contact the Laboratory director whenever in doubt. A reputable

accreditation center will always be very helpful and forthcoming.

• Occasionally, accreditation centers will run out of stock of some CRSs. In that rare

event, the standards lab should be able to recommend alternative sources for CRSs

while they restock their supplies. It is always a good idea to have an emergency

second source of standards identified in case a backup supplier is required.

• Some CRSs have expiration dates. Following strict GLP and GMP guidelines, QA

labs must keep track of those dates, and never use expired CRSs for calibration or

determination of acceptability of their melting point equipment.

• A slight drift in melting point results is expected when the melting point temperatures

obtained with a liquid bath oven are compared to those obtained with a metal block

oven under the same ramping conditions. This difference is to be expected and

generally ignored since it generally falls within the intrinsic uncertainty of the

measurement.

• Use capillary tubes of the same kind, and from the same supplier, to perform

calibrations and to carry out all subsequent measurements. Beware that some

pharmacopeia protocols include specific capillary requirements.

• Failure to clean the tubing before making capillary melting tubes is one of the most

common causes of low melting points and broad melting point ranges. Whenever

possible buy pre-made tubes from reputable sources, to assure the best

reproducibility of results.

• Dry CRS samples carefully and store them in a vacuum dessicator between melting

point determinations. Forty eight hours over P2O5 is a very common recommendation

for drying standards. Follow all standard-specific recommendations.

Accreditation Centers

The following table is a list of accreditation centers which stock melting point CRSs.

Notice that the scope of the centers ranges from local to worldwide.

Keep in mind that certification protocols are constantly being revised and modified. Use

this table as reference only and access the Internet to update the records on this table if

necessary.
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Name Address/Phone E-Mail / Web

WHO Collaborating

Center for Chemical

Reference
Substances

(International)

Apoteket AB

Produktion &Laboratorier

Centrallaboratoriet, ACL
Prismavägen 2, S-141 75

Kungens Kurva

Sweden
Telephone:(+ 46-8)466-1000 

Fax: (+46-8) 740-6040

E-mail:

who.apl@apoteket.se

U.S. Pharmacopeial

Convention, Inc.
(United States)

Reference Standards Order

Department.
12601 Twinbrook Parkway

Rockville, MD 20852

USA
Telephone:

US and Canada: (800) 227-8772

International : (+1-301) 881-0666

Fax: (+1-301) 816-8148

Web:

www.usp.org

LGC PromoChem

(US, UK, Europe and

WHO standards)

LGC Promochem

Queens Rd

TEDDINGTON
Middlesex

TW11 0LY

United Kingdom

Telephone: +44 (0)20 8943 7000
Fax : +44 (0)20 8943 2767

Web:

www.lgcpromochem.com

E-mail:
uk@lgcpromochem.com

National Physical

Laboratory
(United Kingdom)

Teddington TW11 0LW

UK

Web:

www.npl.co.uk.

European Directorate

for the Quality of

Medicines
(Europe)

European Pharmacopeia Council of

Europe

B.P. 907, F-67029
Strasbourg Cedex 1

France.

Telephone: (+33-(0)3) 88 41 20 35
Fax: (+33-(0)3) 88 41 27 71

E-mail:

CRS@pheur.org

Web:
www.pheur.org

French

Pharmacopeia

Reference
Substances

(France)

Agence Française de Sécurité

Sanitaire des Produits de Santé

Direction des Laboratoires et des
Contrôles

Site de Montpellier-Vendargues

635 rue de la Garenne
F-34740 Vendargues

France

Telephone: (+33-(0)4) 67 91 39 00

Fax: (+33-(0)4) 57 87 39 83
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WHO Melting Point Reference Substances

The World Health Organization (WHO) set of Melting Point Reference Substances

contains thirteen compounds.

The WHO Melting Point Reference Substances are supplied primarily for calibration of

different instruments and methods for determination of melting point temperatures

against the method of the International Pharmacopeia (Int. Pharm.), 3rd Ed., Volume 1.

The nominal melting temperatures for the WHO Melting Point Reference Substances

have been laid down on the basis of the results obtained in a collaborative study

according to the capillary method of the Int. Pharm. 2nd Ed (H. Bervenmark, et. al.,

“WHO Melting Point Reference Substances”, Bull. Wld Hlth Org. 28 (1963) 175-188).

The WHO set of Melting-Point Reference Substances contains the following 13

compounds:

WHO Melting-Point Reference Substances

Substance Nominal Melting Range (°C)

Azobenzene 67.8 68.8

Vanillin (*) 81.7 83.0

Benzil 94.8 96.0

Acetanilide 114.4 115.7

Phenacetin (*) 134.7 135.9

Benzanilide 163.5 164.7

Sulfanilamide 164.7 165.9

Sulfapyridine 191.7 192.7

Dicyandiamide 209 210.2

Saccharin 227.2 229.3

Caffeine (*) 235.8 237.0

Phenolphthalein 261.5 263.0

(*) Compounds included in the O100MPS CRS Kit.

The melting range is defined as the temperature range between the onset point (collapse

point) and the clear point (liquefaction point). Heating Rate is 1 °C/minute.

WHO Melting Point Reference Substances are packaged with detailed certificates

including Control Number, Intended Use, Analytical Data, Storage, Directions For Use

and Assigned Melting Point.
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O100MPS CRS Kit

Stanford Research Systems supplies a Calibration Kit, SRS Part# O100MPS, consisting

of three standard compounds with certified melting point temperatures traceable to WHO

CRSs. The kit was specifically designed to check the temperature-scale calibration of

your OptiMelt system according to WHO certification requirements and to perform a

calibration of the temperature scale if necessary.

The three reference substances included in the O100MPS CRS Kit were carefully

selected to match the calibration requirements of your OptiMelt:

SRS CRS Kit – O100MPS

Substance Nominal Melt Point (°C ) (*)

Vanillin 83.0

Phenacetin 135.9

Caffeine 237.0

(*) Clear Points are used for the calibration of the temperature scale.

Each CRS kit includes a label with a detailed listing of:

1) Lot/Batch number.

2) Instructions for use (including sample pretreatment, capillary loading and heater

settings.)

3) Exact melting point procedure used to determine and certify the melting point range.

The Start temperature must be stable, and set 5 °C below the expected melting

range, before the capillary sample is introduced into the metal oven. The Stop

temperature must be set 10 °C above the expected melting point temperature. The

fixed heating rate must be 1.0 ºC/min.

4) Assigned Melting Points.

The melting temperatures for the Melting Point Reference Substances traceable to

WHO International Pharmacopeia have been laid down on the basis of the results

obtained in a collaborative study according to the capillary method of the Int.

Pharm. 2nd Ed (H. Bervenmark, et. al., “WHO Melting Point Reference

Substances”, Bull. Wld Hlth Org. 28 (1963) 175-188).
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Appendix C 

Using Melt Graphs

Melt Graphs

In order to provide a real-time display of the changes detected by the digital camera, a

graphical representation of the “melting process vs. temperature” can be plotted during

the analysis.

The plots (referred to as Melt Graphs) are a simplistic representation of the melting

process calculated by the digital image processor, and are stored in memory as part of

each final report. Melt Graphs can be displayed during and after a melt on the front panel

of the instrument or on a computer screen (using the MeltView software and USB

connection to a host computer). The Digital Image Processor uses the calculated Melt

Graphs to detect onset, meniscus and clear points based on user-programmable thresholds

(i.e. Onset %, Clear % and Single %) stored in the OptiMelt’s internal memory.

Melt Graphs are generic plots, routinely used to review the changes observed by the

camera during a test, and to fine tune automation parameters (i.e. detection thresholds) to

better match visual and automated determinations. Melt Graphs are also appended to all

printed reports for GLP validation of your analysis results.
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Figure 36. Melt Graphs provide a simplified representation of the melt process. Thresholds are

assigned for the onset, meniscus and clear points, and are used by the digital image processor for

automated determinations.
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The three most important qualities of Melt Graphs, which hold true for most wellbehaved

chemicals, are that their detection thresholds are (1) very deterministic, (2) ramp

independent and (3) shared by samples that behave in similar manner during a melt. For

example, most white samples which melt without decomposition share similar

MeltGraphs and detection thresholds.

Figure 37. Melt Graph for phenacetin as a function of heating ramp rate.

Melt Playback (MeltView Software)

The sample images captured by digital camera are also available for real-time transfer to

a PC over the USB interface.

The MeltView software package provided with your OptiMelt can handle real-time

image transfer, allowing you to display and store high-resolution digital images of the

samples (including relevant information such as temperature, time and date) on your

computer screen during analysis. All sample images transferred to the PC are bundled

together as a single package and automatically stored in the computer’s hard disk when

the test is completed. This option provides the most powerful and definitive

documentation infrastructure available from any commercial melting point apparatus.

Stored images may be recalled at any time, and melts can be played back frame-by-frame

or as a movie, by simple moving a cursor back and forth with your mouse. Being able to

replay a test after the fact is an invaluable tool for GLP documentation, fine tuning of

results, and laboratory demonstrations in educational settings.
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The combination of excellent image resolution, high magnification, and the power to

carefully step back and forth through a melt provides dramatically enhanced accuracy

compared to visual determinations. The ability to display the melt so that several people

can view it at once makes the MeltView software package ideal for teaching and

lecturing.
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OptiMelt Remote Programming

Using USB

Introduction

Remote programming of the OptiMelt using USB requires:

• An OS that supports USB (Windows 2000, XP, 98, Mac OS 8/9 or OS X).

• Application software (MeltView from SRS, your own Labview, C++, etc. program or

a terminal emulator such as HyperTerm) that can access a COM/serial port.

• A USB driver for your OS.

• USB hardware on your computer.

• A USB cable.

Virtual Com Port Driver

The OptiMelt USB port is based on the FT245BM chip from FTDI (www.ftdichip.com).

FTDI supplies a Virtual COM Port (VCP) driver for Windows and Mac OS. Once

installed, the VCP driver makes the OptiMelt appear as if it were connected via a normal

COM port (serial port). Program control is possible using any program capable of

communicating with a COM/serial port. The COM/serial port’s baud rate, start, stop, and

parity are ignored by the VCP.

Windows XP, 2000/98

FTDI's Virtual COM Port (VCP) Drivers appear to the system as an extra Com Port (in

addition to any existing hardware Com Ports). Application software accesses the USB

device in the same way as it would access a standard Windows Com Port using the

Windows VCOMM API calls or by using a Com Port  Library. This driver is Windows

XP certified and will be installed automatically (may require an internet connection).

Quick Start

• Plug the OptiMelt into a PC USB port and turn the unit on. Windows will display the

message “Found New Hardware  USB <-> Serial”.

• If the driver is already available on the computer then it will be installed and a few

seconds later “Your new hardware is installed and ready to use” will be displayed.



90 OptiMelt Remote Programming Appendix D

OptiMelt Automated Melting Point System

• If the driver is not on the computer then the Found New Hardware Wizard will start

up. If the PC has internet access, choose “Install the software automatically” and

click ‘Next’. The driver will be downloaded and installed.

• If the PC has no internet access, download the driver from www.ftdichip.com. Be

sure to choose the driver for the FT245BM part. Unzip the file into a temporary

directory. In this case choose “Install from a specific location” in the Found New

Hardware Wizard and locate the file you just downloaded.

• When installation is complete, click ‘Finish’.

• To confirm that the installation has completed successfully, look under the Device

Manager of the System Properties screen.

• Right click on ‘My Computer’ (on the desktop) and select ‘Properties’. In the

Properties window click the ‘Hardware’ tab and then click on ‘Device Manager’.

• In the Device Manager window, expand the Ports list by clicking the ‘+’ next to

‘Ports’. The Virtual COM Port should appear as “USB Serial Port (COM x)”

where x was the next available COM port.
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COM Port Number

Some Applications can only use COM ports within a certain range (e.g. COM1 through

COM4). If this is the case, you may want to manually select the COM port number that

VCP uses.

Be sure not to select a COM port which is already in use. When you return to the Device

Manager Screen you will see that the USB Serial Port installation has been changed to

the new COM number.

• To examine the port properties, right click on ‘USB Serial Port (COMx)’ in the

Device Manager to display the Properties window below.

• To change the COM port number, click on the ‘Port Settings’ tab. Select ‘Advanced’.
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• Click the drop down arrow on ‘COM Port Number’ and scroll to the required COM

port. Select ‘OK’.

Removing the Driver

To remove the FTDI VCP driver, use Add/Remove Programs.

• From the Start Menu, select Control Panel -> Add or Remove Programs.

• In the new window, click on ‘FTDI USB Serial Converter Drivers’.

• Click on ‘Change/Remove’ to remove the drivers (see below).

Testing With Hyperterminal

It is a good idea to test the COM port installation before attempting to write a program to

communicate with your OptiMelt.

• Open Hyperterminal from Start Menu->Programs->Accessories->

Communications->Hyperterminal.

• Enter a configuration name (e.g. OptiMelt on COMx) at the ‘New Connection’

dialog.

• Choose the COM port that VCP installed in the ‘Connect To’ dialog.

• Ignore the COMx settings page – just click OK.

If the OptiMelt is connected and turned on, you should be able to type in *IDN? <Enter>

and get the instrument identification string in response. You can modify the terminal

settings to improve the readability of your session as follows:

• Select ‘Call->Disconnect’ from the Hyperterminal menu.
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• Select ‘File->Properties’ and click on the ‘Settings’ tab.

• Click on ‘ASCII Setup’ and check the “Echo typed characters locally” and “Append

line feeds to incoming line ends” boxes.

• Click ‘OK’ and ‘OK’ again to finish the ‘Properties’ dialog.

• Select ‘File->Save’ to save your HyperTerminal configuration for later use.

This HyperTerminal setup will allow you to try out the OptiMelt commands before you

include them in your program. However, only one application can be connected to a

COM port at a time. If HyperTerminal is running, your program will fail to open the

COM port. Likewise, HyperTerminal will not be able to use the COM port if your

program is running.

Using Multiple OptiMelts with Windows XP

Connecting multiple OptiMelts to a single PC requires Windows XP. In this case, each

new OptiMelt connected will be assigned the next available COM port number. Windows

does not keep track of which OptiMelt is attached to which COM port. If 2 OptiMelts are

switched, Windows won’t know. It is up to the user to keep track of the different units

using serial numbers or system names.

Using Multiple USB Ports with Windows XP

Once an OptiMelt is attached to a specific USB port on a PC, the VCP driver assigns a

COM port number to that USB port. This assignment remains even after the OptiMelt is

removed from the USB port. As a consequence, plugging an OptiMelt into another USB

port will result in a new COM port being assigned to the new USB port. An OptiMelt

plugged into the original USB port will still use the original COM port.

This allows an application to “know” that an OptiMelt is always going to appear as

COMn as long as the same USB port is used. Conversely, it is not a good idea to switch

USB ports since this will require the application to switch COM ports.

Using Multiple USB Ports with Windows 2000 and 98

Only a single OptiMelt may be attached to a Windows 2000/98 PC. The OptiMelt will

appear as the next available COM port. Disconnecting the OptiMelt and connecting a

different USB port will unintall the original VCP driver and re-install it on the new USB

port as the same COM port. Do not connect multiple OptiMelts since only one will be

recognized.
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Mac OS X

Quick Start

• Download the Mac OSX drivers from www.ftdichip.com. Be sure the driver is for the

FT245 part.

• Unstuff it. Run the resulting installer package (e.g. FTDIUSBSerialDriver.pkg). This

installation requires a reboot.

• After the computer has rebooted, plug in the OptiMelt to a USB port and turn it on.

• To verify the installation, run System Preferences and select Network. You should

see the message “New Port Detected” and “usbserial-xxxxx”. The hex number xxxxx

refers uniquely to a specific USB port.

• Click ‘OK’ and then click ‘Apply Now’.

• To view the list of ports, select ‘Show -> Network Port Configurations’. Do not

check the box in front of the usbserial port since it does not connect to the internet.

• Close the Network preferences window.
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Using Multiple OptiMelts with Mac OS X

Multiple OptiMelts may be connected to a single Mac. In this case, each new OptiMelt

connected will be assigned a unique port ‘usbserial-xxxxx’ where xxxxx uniquely refers

to a specific USB port. The OS does not keep track of which OptiMelt is attached to

which port. If 2 OptiMelts are switched, the OS won’t know. It is up to the user to keep

track of the different units using serial numbers or system names.

Using Multiple USB Ports with Mac OS X

Once an OptiMelt is attached to a specific USB port on a Mac, the VCP driver assigns a

usbserial-xxxxx port to that USB port. This assignment remains even after the OptiMelt

is removed from the USB port. As a consequence, plugging an OptiMelt into another

USB port will result in a new usbserial-yyyyy port being assigned to the new USB port.

An OptiMelt plugged into the original USB port will still use the original usbserial-xxxxx

port.

This allows an application to “know” that an OptiMelt is always going to appear as

usbserial-xxxxx as long as the same USB port is used. Conversely, it is not a good idea to

switch USB ports since this will require the application to switch ports.

Removing a Port

• Run System Preferences and select Network.

• To view the list of ports, select ‘Show -> Network Port Configurations’.

• Select the usbserial-xxxxx port you wish to delete and click ‘Delete’.

Testing With a Terminal Emulator

It is a good idea to test the usbserial port installation before attempting to write a program

to communicate with your OptiMelt. Any terminal emulation program will work – do not

use the ‘Terminal’ application installed with OS X. A good program for this is MacWise

(download from www.carnationsoftware.com).

• Download and install MacWise.

• Open MacWise. From the ‘Settings’ menu select ‘Serial Port’ and choose the

‘usbserial’ port which is connected to the OptiMelt.

• If the OptiMelt is connected and turned on, you should be able to type in *IDN?

<return> and get the instrument identification string in response.

• You can modify the terminal settings to improve the readability of your session as

follows - from the ‘Settings’ menu, select ‘Display Mode’ and choose ‘Half Duplex’.

Using Mac OS 8/9

• Download the Mac OS8/9 drivers from www.ftdichip.com. Be sure the driver is for

the FT245 part.

• Unstuff it. Move the resulting file (e.g. USBSerialConverter_XXX) into the

System/Extensions folder. Reboot the computer.
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Using Commands

Command Format

Communications with the OptiMelt uses ASCII characters. Commands may be in either

UPPER or lower case. A command to the OptiMelt consists of a four character command

mnemonic with optional ?, a parameter if necessary, and a command terminator. The

command, arguments and terminator may be separated by spaces. The terminator must be

a linefeed <lf> or carriage return <cr>. No command processing occurs until a terminator

is received.

Multiple commands may be sent on one command line by separating them with

semicolons (;). In this case, no commands are executed until a terminator is received.

There is no need to wait between commands. The OptiMelt has a 256 character input

buffer and processes commands in the order received. Similarly, the OptiMelt has a 256

character output buffer to store output until the host computer can receive it.

The present value of a particular parameter may be determined by querying the OptiMelt

for its value. A query is formed by appending a question mark '?' to the command

mnemonic and omitting the desired parameter from the command. Values returned by the

OptiMelt are sent as a string of ASCII characters terminated by a carriage return <cr>. If

multiple query commands are sent on one command line (separated by semicolons, of

course), the answers will be returned individually, each with a terminator.

Examples of Commands
INIT 86.5 <lf> Set the Start Temperature to 86.5 °C

INIT? <lf> Query the Start Temperature

*IDN? <lf> Query the Device Identification String

Command Syntax

The four letter mnemonic (shown in CAPS) in each command sequence specifies the

command. The rest of the sequence consists of parameters. Parameters shown in { } are

not always required. Generally, parameters in { } are required to set a value in the

OptiMelt. Multiple commands may be sent on one command line by separating them with

semicolons (;).

The present value of a parameter may be determined by sending a query command.

• Commands that MAY be queried show a question mark in parentheses (?) after the

mnemonic.

• Commands that are ONLY queries have a '?' after the mnemonic, with no

parentheses.

• Commands that MAY NOT be queried have no '?'.

A query is formed by including the question mark ? after the command mnemonic and

omitting the queried parameter from the command. The query parameters shown in { }
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are NOT sent with a query. The query returns the value of these parameters. Values are

returned as a string of ASCII characters (unless otherwise noted).

Do NOT send ( ) or { } as part of the command.

For example, the command sequence INIT (?) {x} is used as follows.

INIT 86.5 Set the Start Temperature to 86.5 °C.

INIT ? Query the Start Temperature.

Variables are defined as follows.

i, d, n integers

x real number

s text strings

All numeric variables may be expressed in integer, floating point or exponential formats

(i.e. the number five can be either 5, 5.0, or 0.5E1). Strings are sent as a sequence of

ASCII characters.

USB Queue Display

To help find program errors, the OptiMelt can display the USB buffer on the screen. This

screen is accessed by touching USB Q in the System tab. The Queue display may slow

down communications and should be displayed only when testing or debugging a host

program. Press Done to exit from this display.

The upper half of the Queue display is the Receive Queue. These are the most recent

characters which have been received by the OptiMelt (displayed in all UPPER case).

Commands which have already been executed are shown in normal text. Commands

which have not yet been executed are shown with a gray background. Command errors

are shown in inverse text.

The lower half of the Queue display is the Transmit Queue. These are the most recent

characters which have been placed in the output buffer. Characters which have already

been sent over the interface are shown in normal text. Characters which are waiting to be

sent are shown with a gray background.
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System Commands

*IDN ? Identification

The *IDN? query returns the OptiMelt's device identification string. This string

is in the format "Stanford_Research_Systems,MPA100,s/n00001,ver010". In this

example, the serial number is 00001 and the firmware version is 010.

SNUM ? Serial Number

The SNUM? query returns the unit serial number.

FREV ? Firmware Revision

The FREV? query returns the OptiMelt’s firmware revision code.

NAME (?) {s} System Name

The NAME command sets (queries) the System Name. The string s is the name

and is converted to UPPER case.

Example

NAME my mpa Sets the Name to "MY MPA".

NAME? Returns the System Name, MY MPA in this case.

MENU d Display Screen

The MENU d command sets the current screen menu according to the list below.

In order to perform melting point determinations, the screen MUST be set to the

Melting Point screen (using MENU 0).

d screen

0 Melting point screen

1 Timer screen

2 Thermometer screen

3 Temperature log chart

4 Temperature log table

5 Melting point report

6 Automated determination graph

Example

MENU 0 Shows the Melting Point screen.

MODE? Instrument Mode

The MODE? query returns the OptiMelt’s operating mode d according to the list

below.

In order to perform melting point determinations, the screen MUST be set to the

Melting Point screen (using MENU 0).

d mode

0 The instrument is operating as a melting point apparatus

1 The instrument is operating as a timer

2 The instrument is operating as a thermometer
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MESG (?) {s} Message

The MESG s command sends the message string s to the screen. The user must

clear this message by touching a button.

The MESG? query returns 1 if the message has not been cleared and 0 if all

messages have been cleared.

Example

MESG warning Displays the message "WARNING" on the screen.

MESG? Returns 1 if until the message has been cleared from the front

panel, and 0 when all messages have been cleared.

*TST ? Self-Test

The *TST ? query performs a self-test and returns 0 if the test passes. Any code

other than 0 indicates an error or fault.

Temperature and Oven Commands

OOFF Turn Oven Off

The OOFF command terminates the melt sequence and turns the oven off.

TBDF (?) {i} Display Format

The TBDF command sets (queries) the Display Format of the temperature in the

Melt and Tmeter screens. The parameter i selects a Display Format below.

i format

0 Big Numbers

1 Trend Graph

2 State Icon

Example

TBDF? Returns the temperature display format i.

TBDF 1 Sets the temperature display to Trend Graph.

TEMP? Read Temperature

The TEMP? query returns current temperature in degrees C.

If the Melt Screen is displayed, TEMP? returns the oven temperature.

If the Tmeter Screen is displayed, TEMP? returns the RTD temperature. If no

RTD is attached, TEMP? returns its maximum value (799.0).

THST (?) {n} Oven Timeout

The THST command sets (queries) the Oven Off Timeout value. This is the

timeout for the oven to remain hot without use. If the timeout expires without a

melting point measurement taking place, the oven will be turned off.

The parameter n is the Oven Off Timeout value in milliseconds.

Example

THST? Returns the Oven Timeout in milliseconds.

THST 600000 Sets the Timeout to 10 minutes (600,000 ms).
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Melting Point Determination Commands

INIT (?) (x} Start Temperature

The INIT command sets (queries) the Start Temperature in degrees C.

The Start Temperature must be lower than the Stop Temperature. The command

will be ignored if x is greater than the Stop Temperature.

Example

INIT? Returns the Start Temperature.

INIT 105 Sets the Start Temperature to 105ºC.

FINT (?) (x} Stop Temperature

The FINT command sets (queries) the Stop Temperature in degrees C.

The Stop Temperature must be higher than the Start temperature. The command

will be ignored if x is less than the Start Temperature.

Example

FINT? Returns the Stop Temperature.

FINT 125 Sets the Stop Temperature to 125ºC.

FRRA (?) {x} Rate/minute

The FRRA command sets (queries) the ramping Rate/minute in degrees C per

minute.

Example

FRRA? Returns the ramping rate.

FRRA 1.5 Sets the ramping rate to 1.5ºC/minute.

MPBP (?) {i} Beep

The MPBP command sets (queries) the Melting Point Beep. The parameter i

specifies On (1) or Off (0).

If enabled the instrument will beep when it reaches its temperature target.

Example

MPBP? Returns the Beep state (on or off).

MPBP 1 Turns the Beep on.

MPST? Melting Point State

The MPST? query returns the state of the melting point determination, i,

according to the table below.

i state

0 Not performing a melt, neither fan nor heater on

1 Heating up to the start temperature

2 Holding at the start temperature, waiting to start melt

3 Capillary thermal stabilization (a very short state)

4 Melting, ramping to the stop temperature

5 Cooling down to the start temperature via fan

6 Cooling down to room temperature via fan

7 Slowly cooling to the start temperature without the fan
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Automated Determination Commands

AMDE (?) {i} Detection

The AMDE command sets (queries) the Melting Point Determination Mode to

Camera (i=1) or Visual Only (i=0).

Example

AMDE? Returns the determination mode (camera or visual).

AMDE 1 Sets the determination to camera (automatic).

OPTP (?) {n} Onset Point Threshold

The OPTP command sets (queries) the Onset Point Threshold percentage. The

integer n is the percentage from 0 to 100.

Example

OPTP? Returns the onset point threshold percentage.

OPTP 70 Sets the onset point threshold to 70%.

CPTP (?) {n} Clear Point Threhold

The CPTP command sets (queries) the Clear Point Threshold percentage. The

integer n is the percentage from 0 to 100.

Example

CPTP? Returns the clear point threshold percentage.

CPTP 10 Sets the clear point threshold to 10%.

SPTP (?) {n} Single Melting Point Threshold

The SPTP command sets (queries) the Single Melting Point Threshold

percentage. The integer n is the percentage from 0 to 100.

Example

SPTP? Returns the single melting point threshold percentage.

SPTP 50 Sets the single melting point threshold to 50%.

AOPT? Read the Onset Point

The AOPT? query returns the onset point from the most recent determination in

degrees C.

ACPT? Read the Clear Point

The ACPT? query returns the clear point from the most recent determination in

degrees C.

ASPT? Read the Single Melting Point

The ASPT? query returns the single melting point from the most recent

determination in degrees C.
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Report Generation Commands

AMAV (?) {i} Calculate Stats

The AMAV command sets (queries) the Calculate Stats mode. The parameter i

selects Skip (0) or Calculate (1). If set to Calculate, the average of the results for

all 3 capillaries will be displayed in the report.

Example

AMAV? Returns the calculate stats mode.

AMAV 0 Sets the unit to Skip the stats in the report.

AMRS (?) {i} Results Display

The AMRS command sets (queries) the melting point results display type. The

parameter i selects MP Range (0), Single MP (1) or Both (2).

Example

AMRS? Returns the melting point results display type.

AMRS 0 Display the MP Range in the report.

BTCH (?) {s} Batch #

The BTCH command sets (queries) the Batch # as it will appear in the melt

report. The string s is the batch and is converted to UPPER case.

Example

BTCH? Returns the Batch # string.

BTCH 376VF0 Set the Batch # to 376VF0.

CHEM (?) {s} Chemical Name

The CHEM command sets (queries) the Chemical Name as it will appear in the

melt report. The string s is the name and is converted to UPPER case.

Example

CHEM? Returns the Chemical Name string.

CHEM caffeine Set the Chemical Name to CAFFEINE.

PHTH (?) {i} Thermodynamic Melting Point

The PHTH command sets (queries) whether the instrument will use

Thermodynamic correction. The parameter i selects Skip (Pharmacopeia MP,

i=0) or Calculate (Thermodynamic MP, i=1).

Example

PHTH? Returns the Thermodynamic MP mode.

PHTH 0 Set to Pharmacopeia MP (skip thermodynamic correction).

THCF (?) {x} Thermodynamic Correction Factor

The THCF command sets (queries) the thermodynamic correction factor to the

value x. This factor is used to calculate the thermodynamic MP.

Example

THCF? Returns the Thermodynamic Correction factor.

THCF 1.1 Set the Thermodynamic Correction factor to 1.1.
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MPRG? Read Melting Point Report

Returns the text melt report specified by the last MPRS command. A typical

response is shown below. Each line is terminated with a <CR>.

SRS OPTIMELT

Report ID: 17

Tue, September 14, 2004    08:13 AM

Chemical: Vanillin

Camera  Left    Center  Right

Range     82.2    81.8    81.9

          83.3    83.0    83.2

Stats:  Range     82.0 -   83.2

        Single pt         82.7

Start temp:       78.0degrees C

Stop temp:        88.0degrees C

Halt temp:        85.1degrees C

Rate:      1.0degrees C/minute

Onset threshold:        70%

Clear threshold:        10%

Thermo corr. factor:       1.0

Thermodynamic Correction:         -1.0degrees C

Last block calibration: 27Aug04

Block cal expires: 27Aug05

Last detector calibration: 27Aug04

Serial number 00100

Firmware 010 09/03/04 11:48

Note

Every line of this response must be read before issuing any more query

commands.

MPRS (?) (n) Choose Melting Point Report

The MPRS command sets (queries) which melt report to return with the MPRG?

query. The index n=0 specifies the most recent report, n=1 the next most recent,

and so forth.

MPRC1 Clear Melting Point Reports

Clear all 8 melt reports.
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Backlight Commands

BLEN (?) {i} Backlight Saver Enable

The BLEN command sets (queries) the Backlight Saver. The parameter i selects

Disabled (0) or Enabled (1).

Example

BLEN? Returns 1 if the Backlight Saver is Enabled, or 0 if Disabled.

BLEN 1 Enables the Backlight Saver.

BLIT (?) {i} Backlight On/Off

The BLIT command sets (queries) the state of the LCD screen backlight. The

parameter i selects On (1) or Off (0).

Example

BLIT? Returns 1 if the backlight is On, or 0 if Off.

BLIT 1 Turns the screen backlight On.

BLOF (?) {n} {s} Backlight Turn-Off Time

The BLOF command sets (queries) the Backlight Turn-Off Time of day. The

parameter n is the time of day in milliseconds from midnight or the string s is the

time in the format "9:30PM". Do not use both n and s in the command. The

BLOF? query returns the value n in ms.

Example

BLOF? Returns the Turn-Off Time in ms.

BLOF 9:30pm Sets the Turn-Off Time to 9:30 PM.

BLOF 77400000 Sets the Turn-Off Time to 77,400,000 ms after midnight

(9:30PM).

BLON (?) {n} {s} Backlight Turn-On Time

The BLON command sets (queries) the Backlight Turn-On Time of day. The

parameter n is the time of day in milliseconds from midnight or the string s is the

time in the format "9:30PM". Do not use both n and s in the command. The

BLON? query returns the value n in ms.

Example

BLON? Returns the Turn-On Time in ms.

BLON 9:30pm Sets the Turn-On Time to 9:30 PM.

BLON 77400000 Sets the Turn-On Time to 77,400,000 ms (9:30PM).

BLTD (?) {n} Backlight Delay

The BLTD command sets (queries) the Backlight Saver Delay. The parameter n

is the Delay in milliseconds.

Example

BLTD? Returns the Backlight Saver Delay in ms.

BLTD 300000 Sets Delay to 5 minutes (300,000 ms).
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